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المنظور

)الرسم ثلاثي الأبعاد(

للرسم ثلاثي الأبعاد ميزة خاصة، أفُسِّر ذلك.	 

هل أستطيع رسم الشكل السابق؟ 	 

الوحدة الرابعة 
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درسْتُ في الوحدة الثالثة الرسم ثنائي الأبعاد، الذي يتكون من بعُْدين، ويرُسَم في مستوى واحد، ورسمْتُ 
العديد من الأشكال الهندسية ثنائية الأبعاد. ولكن، قد يتعيَّن أحياناً رسم جسم كما تراه العين؛ لتوضيح فكرته، 

ح معالم الجسم عند رسمه. وتسهيل فهمه؛ ما يتطلَّب إضافة بعُْد ثالث إلى البعُْدين الأساسيين، يوُضِّ

يطُلقَ على الرسم ثلاثي الأبعاد اسم المنظور، ومن أمثلته: المكعب، ومتوازي المستطيلات، والأسطوانة، 
والمنشور، والهرم.

يتُوقَّع من الطالب بعد دراسة هذه الوحدة أن:

ف مفهوم الرسم ثلاثي الأبعاد.	  يعُرِّ

د مستويات الرسم ثلاثي الأبعاد.	  يحُدِّ

ف أنواع المناظير.	  يتعرَّ

يتعرَّف خطوات رسم المناظير الآيزومترية والجبهية.	 

يرسم المناظير التي تحوي سطوحًا مائلةً. 	 

يرسم المناظير التي تحوي أجزاءً أسطوانيةً.	 

يعمل مُجسَّمات تحاكي بعض المناظير محاكاة دقيقة.  	 
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777

من خلال الشكلين المجاورين، ما الفرق في طريقة رسم كل منهما؟

انظر وتساءل 

ما الخطوات والشروط الواجب تطبيقها عند رسم الشكل المجاور؟ 

أحاول مع زملائي استنتاج هذه الخطوات.

 استكشف
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اقرأ وتعلم

يتطلَّب رسم أشكال الأعمال الهندسية جميعها استخدام سطح ثنائي الأبعاد )ورقة الرسم(، وذلك لتوضيح 
الأفكار، وإيصال المعلومات اللازمة عن الشكل المراد رسمه إلى المعنيين بذلك. ولكن، قد يتطلَّب الأمر 
أحياناً رسم الأجسام بصورتها الحقيقية كما تراها العين البشرية، أو بصورة مقاربة لحقيقتها، وذلك بإضافة 
بعُْد ثالث )ع( إلى البعُْدين الأساسين )س، ص(، فيصبح الرسم ثلاثي الأبعاد )س، ص، ع(، في ما يعُرَف 

بالمنظور.

يبُيِّن الشكل )4-1( محاور الرسم ثلاثي الأبعاد. 

والعرض،  )الطول،  الثلاثة  بأبعاده  الشكل  إظهار  أهمها:  عِدَّة،  مزايا  )المنظور(  الأبعاد  ثلاثي  للرسم 
والرتفاع(، وتقديم فهم سريع واضح لهيئة الشكل، ورؤية أوجه المُجسَّم جميعها. يذُكَر أن الرسم ثلاثي الأبعاد 
سَهَّل رسم المُجسَّمات، مثل: المكعب، والمنشور، والأسطوانة، ومتوازي المستطيلات، أنظر الشكل )2-4(.

مفهوم الرسم ثلاثي الأبعاد أولًا

الشكل )4-2(: بعض أشكال الرسم ثلاثي الأبعاد.
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مستويات الرسم ثلاثي الأبعاد 

يمكن النظر إلى أيِّ منظور من ستة أوجه مختلفة، يبُيِّنها الشكل )4-3/أ(، وهي: 

.)Rear( 4 - الوجه الخلفي              .)Front( 1 - الوجه الأمامي

.)Bottom( 5 - الوجه السفلي              .)Top( 2 - الوجه العلوي

.)Left Side( 6 - الوجه الجانبي الأيسر           .)Right Side( 3 - الوجه الجانبي الأيمن

الشكل )4-3/أ(: الأوجه الستة للمنظور.

الشكل )4-3/ب(: الأوجه الستة للمنظور.
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الوجه العلوي

الوجه الجانبي الأيمن

الوجه الجانبي 
الأيسر

الوجه الخلفي

الوجه الأمامي

الوجه السفلي

ويبُين الشكل )4-3/ب( المنظور باللون الأخضر، والأوجه الستة له الواضحة بالشكل.
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الذي بجانبه،  المنظور الستة. وفيه يتعامد كل مستوى مع المستوى  يبُيِّن الشكل )4-3/جـ( مستويات 
ويتوازى مع المستوى المقابل له. وقد وُضِع المنظور )البيت( في صندوق، ثم طبُعِ كل مستوى من هذه 
المستويات على أحد أوجه الصندوق الداخلية، ثم فتُحِ الصندوق، فنتجت المستويات الستة للمنظور كما 

في الشكل )4-3/د(.

مستويات المنظور )البيت( الستة.

الشكل )4-3/د(.الشكل )4-3/جـ(.
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يمكن الكتفاء في الرسم الصناعي بثلاثة أوجه لرسم أيِّ منظور 
ثلاثي الأبعاد، وتسُمّى هذه الأوجه المستويات الأساسية الثلاثة 

المتعامدة، كما في الشكل )4-4(، وهي: 

1 - المستوى الأمامي الذي يتألَّف من الطول والرتفاع.

2 - المستوى الجانبي الذي يتألَّف من العرض والرتفاع. 

3 - المستوى الأفقي الذي يتألَّف من الطول والعرض. 

الشكل )4-4(: المستويات الثلاثة للرسم 

ثلاثي الأبعاد.
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هو  )ع(  الرتفاع  أن  السابق  الشكل  من  يتضح 
المحور المشترك بين المستوى الأمامي والمستوى 
المشترك  المحور  العرض )س( هو  الجانبي، وأن 
بين المستوى الأفقي والمستوى الجانبي، وأن الطول 
)ص( هو المحور المشترك بين المستوى الأمامي 
منظورًا   )5-4( الشكل  يمُثِّل  الأفقي.  والمستوى 

يحوي المستويات الرئيسة الثلاثة المتعامدة.

فْتُ في الوحدة السابقة أن السطوح التي يقع  تعرَّ
المقابل  الجدار  على  وتظهر  عمودياًّ،  النظر  عليها 
لزاوية النظر تسُمّى المساقط، وهي ثلاثة: المسقط 

الشكل )4-5(: منظور يحوي المستويات الثلاثة.الأمامي، والمسقط الجانبي، والمسقط الأفقي.

التمرين )1(

د المسقط الأمامي، والجانبي، والأفقي في كل منظور من المناظير المُبيَّنة في الشكل الآتي: أحُدِّ
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أنواع الرسوم ثلاثية الأبعاد ا ثانيًّ

ينقسم الرسم ثلاثي الأبعاد )المنظور( قسمين رئيسين، هما: المنظور المركزي، والمنظور المتوازي.
ع أشعة النظر جميعها في نقطة واحدة، في حين يمتاز المنظور المتوازي  يمتاز المنظور المركزي بتجمُّ

بسقوط جميع أشعة النظر على الجسم في اتجاه واحد، وعلى نحوٍ متوازٍ، أنظر الشكل )6-4(.

الشكل )4-6(: الإسقاط في المنظور المركزي، والمنظور المتوازي. 4-5

4-7

6-1 4-326-26-3

4-32

6-4

6-5

+
+

6-66-76-86-96-1011-12

)Perspective Projection( 1- المنظور المركزي

يشبه الرسم ثلاثي الأبعاد في المنظور المركزي الصورة الفوتوغرافية؛ إذ يظهر الجسم كما تراه العين 
البشرية، وتظهر فيه الصورة كأنها حقيقية. وفي هذا النوع من المناظير تسقط أشعة النظر على الجسم 
من نقطة محددة في الفراغ، فتقطع حواف الجسم لتشُِّكل خيالً ثنائي الأبعاد على سطح الإسقاط. تعتمد 
أبعاد هذا المنظور على بعُْد مركز النظر عن الجسم، وبعُْد سطح الإسقاط عن الجسم؛ إذ تبدأ عناصر 
عند  وتزداد وضوحًا وحجمًا  بعُْد،  من  فتبدو صغيرة  المُشاهِد،  نظر  بعَُدَتْ عن  كلما  بالتناقص  الشكل 

القتراب من مصدر الرؤية. والشكل )4-7( يبُيِّن بعض المناظير المركزية. 

الشكل )4-7(: بعض الرسوم التي تمُثِّل المنظور المركزي.
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أمّا  )الديكور(،  والتصميم  والعمارة  البناء  مهندسي  وبعض  الفنانون  المناظير  من  النوع  هذا  يستعمل 
للتعبير بصورة مُجسِّمة  الصناعيون من المهندسين والفنيين فيستعملون المنظور المتوازي في ما بينهم؛ 

على ورقة الرسم عمّا يريدون إيضاحه.

)Parallel Projection( 2- المنظور المتوازي

هناك نوعان من المنظور المتوازي، هما: 
أ - المنظور المتساوي الآيزومتري: يمتاز هذا المنظور بوجهين مائلين يرُسَم كلٌّ منهما بزاوية )30°(.
وبالرغم من استعمال الأبعاد الحقيقية فيه، فإن بعض الأشكال ل تظهر على حقيقتها. يرُسَم الرتفاع 
في هذا النوع من المناظير بشكل رأسي، في حين يرُسَم العرض والطول مائلين بزاوية )°30(. يعَُدُّ 
المنظور المتساوي الآيزومتري الأكثر استعمالً من الصناعيين؛ نظرًا إلى سهولة رسمه، ووضوح 

سطوحه بالنسبة إلى بعضها، أنَظرُ الشكل )8-4(.

الشكل )4-8(: المنظور الآيزومتري.
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الشكل )4-9(: بعض المناظير الآيزومترية.

يبُيِّن الشكل )4-9( بعض المناظير الآيزومترية.
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الطول  يرُسَم  بزاوية )°45( لأحد سطوحه. وفيه  مائلًا  الجبهي  المنظور  يرُسَم  الجبهي:  المنظور  ب- 
بشكل أفقي، ويميل العرض فيه بزاوية )°45(، في حين يبقى الرتفاع رأسياًّ، أنظر الشكل )10-4(.

الشكل )4-10(: المنظور الجبهي.

يقُسَّم المنظور الجبهي تبعًا لأبعاد رسم الوجه الجانبي المائل  ثلاثة أقسام:

المنظور الجبهي الطويل: يرُسَم الوجه الجانبي لهذا المنظور بأبعاده الحقيقية، وهو قليل الستعمال،   .1
أنظر الشكل )4-11/ أ(.

المنظور الجبهي القصير: يرُسَم الوجه الجانبي لهذا المنظور بنصف أبعاده الحقيقية، وهو أكثر   .2
الأنواع استعمالً، أنظر الشكل )4-11/ ب(. 

أبعاده الحقيقية، وأكثر من  العام: يرُسَم الوجه الجانبي لهذا المنظور بأقل من  المنظور الجبهي   .3
نصف أبعاده الحقيقية، وهو غير مُستعمَل في الرسم الصناعي.

تسُتعمَل هذه الأنواع تبعًا لتناسب أبعاد المنظور بعضها مع بعض، ومع ورقة الرسم.

أفُسِّر

لماذا يرُسَم المنظور الجبهي والمنظور الآيزومتري بصورة مائلة؟

يبُيِّن الشكل )4-11( بعض أنواع المنظور الجبهي.

)أ( المنظور الجبهي الطويل.                      )ب( المنظور الجبهي القصير.

الشكل )4-11(: بعض أنواع المنظور الجبهي.

45°

المسقط 
الأمامي

المسقط 
الأمامي

المسقط 
الأفقي

المسقط 
الأفقي

المسقط 
الجانبي

المسقط 
الجانبي

45°45°

45°



15

يتعيَّن على الطالب الإحاطة بمبادئ الرسم ثلاثي الأبعاد 
للمنظور المتوازي بنوعيه الآيزومتري والجبهي؛ نظرًا إلى 
شيوع استعمالها في الرسوم التنفيذية الصناعية الهندسية، 
بين  والرسوم  المعلومات  تبادل  تسهيل  من  به  تمتاز  ولما 

الصناعيين.

والختلاف  التشابه  أوجه  ما 
والمنظور  الجبهي  المنظور  بين 

الآيزومتري؟

ر أُفكِّ

نشاط 

أمُيز المنظور الآيزومتري من المنظور الجبهي في الأشكال الآتية:

)أ(
)ب(

)جـ(

)د(
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رسم المنظور المتوازي ثالثًا

يتناول هذا الدرس الطريقة العامة لرسم المنظور الجبهي والمنظور الآيزومتري، ويعرض لطريقة رسم 
الزوايا والسطوح المائلة والدوائر والأجسام الأسطوانية في المنظور الآيزومتري بوصفه أكثر أنواع المناظير 
ف كيفية وضع الأبعاد على المنظور بتطبيق أسس وضع الأبعاد التي أشُير إليها سابقاً. استعمالً، فضلًا عن تعرُّ

1- رسم المنظور الجبهي

أرَسُم المنظور الجبهي الطويل كما في الشكل )12-4(.  

الشكل )4-12(: المنظور الجبهي.
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الرسم التوضيحي الخطوة الرقم

رسم  ثم  )أ(،  ولتكن  الرسم،  لوحة  على  نقطة  تحديد 

المجاور،  الشكل  في  كما  للجسم  الأمامي  الوجه 

وبحسب الأبعاد المعطاة.
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رسم خط مائل بزاوية )°45( من النقطة )أ( بحسب 

البعُْد المعطى، فتنتج النقطة )ل(.

2

خطوات التنفيذ
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خطوات التنفيذ

الرسم التوضيحي الخطوة الرقم

الوجه  زوايا  من  )أل(  للخط  موازية  خطوط  رسم 

الأمامي.

3

موازية  وخطوط  )أج(،  للخط  موازية  خطوط  رسم 

للخط )أب(، فينتج الشكل المطلوب.

4

المثال )1( 

ل الوجه الأمامي في الشكل المجاور إلى منظور جبهي. أحُوِّ

بزاوية  المنظور  أرَسُم عرض 
الأمامي  الوجه  زوايا  من   )45°(

كلها، وبالطول نفسه.
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خطوات التنفيذ

أكُمِل خطوط المنظور بتوصيل 
نهايات الخطوط.
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التمرين )2(

ل الأوجه الأمامية إلى مناظير جبهية باتجاه اليمين في الشكل الآتي، مُستعمِلًا مقياس رسم مناسباً. 1 - أحُوِّ

ل الأوجه الأمامية إلى مناظير جبهية باتجاه اليسار في الشكل الآتي، مُستعمِلًا مقياس رسم مناسباً. 2 - أحُوِّ
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التمرين )3(

أرَسُم المناظير الجبهية المُبيَّنة في الشكل الآتي باستعمال مقياس الرسم )1:1(.
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2- رسم المنظور الآيزومتري 

أرَسُم المنظور الآيزومتري كما في الشكل )13-4(.

الشكل )4-13(: منظور آيزومتري.
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خطوات التنفيذ

الرسم التوضيحي الخطوة الرقم

تحديد النقطة )أ(، ثم رسم القطعة المستقيمة )أ و( التي 

تمُثِّل الرتفاع بحسب الأبعاد المعطاة. 

1

رسم القطعة المستقيمة )أب( التي تميل بزاوية )30°( 

بالزاوية  تميل  التي  م(  )أ  والقطعة  اليمين،  جهة  من 

نفسها من جهة اليسار بحسب الأبعاد المعطاة. 

2

رسم الوجه الأمامي )أ ب ج د هـ و( بحسب الأبعاد 

المعطاة.
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الرسم التوضيحي الخطوة الرقم

رسم قطع مستقيمة موازية للقطعة )أ م( بالطول نفسه 

من زوايا الوجه الأمامي.

4

للقطعة موازية  )م(  النقطة  من  مستقيمة  قطعة  رسم 
و(،  )هـ  للقطعة  موازية  مستقيمة  وقطعة  و(،  )أ   

نفسها،  بالطريقة  مستقيمة  قطع  من  تبقىّ  ما  وكذلك 

فينتج الشكل المطلوب.

5

المثال )2( 

ل الوجه الأمامي في الشكل المجاور إلى منظور آيزومتري. أحُوِّ

بزاوية  المنظور  أرَسُم عرض 
الأمامي  الوجه  زوايا  من   )30°(

كلها، وبالقياس نفسه.

بتوصيل  المنظور  رسم  أكُمِل 
نهايات الخطوط، ومراعاة الزاوية 
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أقُارِن بين المنظور الجبهي والمنظور الآيزومتري من حيث خطوات تنفيذ الرسم كما في الشكلين: 
)4-12(، و )13-4(.

خطوات التنفيذ
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التمرين )4(

ل الأوجه الأمامية إلى مناظير آيزومترية في الشكل الآتي باستعمال مقياس رسم مناسب. أحُوِّ

أُناقِش زملائي

لكلِّ  الأمامي  الوجه  تحويل  كيفية  الآيزومتري من حيث  المنظور  الجبهي عن  المنظور  يختلف  فيمَ 
منهما؟
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التمرين )5(

أرَسُم المناظير الآيزومترية في الشكل الآتي باستعمال مقياس الرسم )1:1(.
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التمرين )6(

أرَسُم المناظير الآيزومترية في الشكل الآتي باستعمال مقياس الرسم )1:1(.
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رسم المناظير الآيزومترية التي تحوي سطوحًا مائلةً

درسْتُ سابقاً طريقة رسم المنظور ذي السطوح المتعامدة، ولكن توجد مناظير أكثر صعوبة قد تحوي 
ف في هذا الدرس كيف يرُسَم المنظور ذو السطوح المائلة.  سطوحًا مائلةً، وسأتعرَّ

في ما يأتي بعض الإرشادات التي تسُهِّل عملية الرسم: 

ل أن تكون ملتقى المحاور الرئيسة الثلاثة(.  أ  - بدء الرسم من نقطة مرئية على المُجسَّم )يفُضَّ
ب- رسم الأوجه المرئية أولً؛ للتقليل من الخطوط غير المرئية التي ستزُال في ما بعد.

جـ- البدء برسم المحاور الرئيسة الثلاثة، والخطوط المتوازية لها كلها، ثم رسم الخطوط الأخرى.
د - الزوايا المعطاة بالدرجات في المناظير ل تظهر بقيمتها الحقيقية في الرسم الآيزومتري؛ لذا يعُتمَد 

د الزوايا. على الأبعاد التي تحُدِّ
هـ- لرسم السطوح المائلة، قد يرُسَم أحياناً متوازي مستطيلات يمُثَّل أكبر طول، وأكبر عرض، وأكبر 

ارتفاع للمُجسَّم، ثم تحُدَّد نقاط السطح المائل. 
و - لرسم بعض المناظير، قد ترُسَم كتل مُركَّبة بعضها مع بعض، ثم تحدد السطوح المائلة. 

المثال )3( 

أرَسُم المنظورالآيزومتري ذا السطح المائل المُبيَّن في الشكل الآتي.
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خطوات التنفيذ

الرسم التوضيحي الخطوة الرقم

رسم متوازي المستطيلات حسب الأبعاد الكبرى الموجودة 

في المُجسَّم )الطول، والعرض، والرتفاع(.
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الرسم التوضيحي الخطوة الرقم

تحديد النقاط )أ ب جـ د( على الشكل بحسب الأبعاد 

المعطاة.

2

من   )30°( بزاوية  هـ(  )ج  المستقيمة  القطعة  رسم 

قطعة  رسم  ثم  مم،   )10mm( وبطول  اليسار،  جهة 

مستقيمة  توازي )ج ه( من النقطة )د(.

3

)أ و(، وقطعة  النقطتين  بين  بقطعة مستقيمة  الوصل 

مستقيمة بين النقطتين )ب هـ(.

4

مسح الخطوط الزائدة، فينتج الشكل المطلوب. 5
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التمرين )7(

أرَسُم المناظير الآيزومترية المُبيَّنة في الشكل الآتي باستعمال مقياس الرسم )2:1(.
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فائدة

يؤدي استعمال الطبعات الهندسية إلى توفير الجهد والوقت، وبخاصة عند رسم الأشكال البيضوية 
والدائرية في المناظير الآيزومترية.

التمرين )8(

أرَسُم المنظور الآيزومتري المُبيَّن في الشكل الآتي باستعمال مقياس الرسم )1:1(.
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الشكل )4-14(: منظور آيزومتري يحوي سطوحًا مائلةً 

وأجزاءً أسطوانيةً.
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رسم الأجزاء الأسطوانية 

ف في هذا الدرس كيفية رسم  فْتُ طريقة رسم المناظير الآيزومترية ذات السطوح المائلة، وسأتعرَّ تعرَّ
الأجسام والأجزاء الأسطوانية في المناظير الآيزومترية، كما في الشكلين )4-14( و)15-4(.

تظهر الدوائر في المنظور الآيزومتري على شكل بيضوي، وترُسَم بطرائق مختلفة؛ إمّا برسم الدوائر 
بالإحداثيات، وإمّا برسم الدوائر باستعمال المربع المحيط بالدائرة أو بالطريقة التقريبية التي ستعُتمَد في هذا 

الكتاب لسهولتها وسرعتها.

البيضوي   البيضوي في ثلاثة مستويات )أمامي، وجانبي، وأفقي(، ويتطلَّب رسم الشكل  يرُسَم الشكل 
تحديد مراكز لرسم أربعة أقواس يمُثِّل اتصالها الشكل البيضوي.

كان مستوى سطح  في حال  التقريبية،  الطريقة  باستخدام  المناظيرالآيزومترية  في  الدائرة  يمكن رسم 
الشكل البيضوي باتجاه اليمين، أو اليسار، أو في المستوى الأفقي بالطريقة نفسها. 

الشكل )4-15(: منظور آيزومتري يحوي 

أجزاءً أسطوانيةً.

الشكل )4-16(: رسم الدائرة بالطريقة التقريبية من جهة اليمين.
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في ما يأتي الخطوات الواجب اتباعها لرسم الدائرة المُبيَّنة في الشكل )16-4(:

الرسم التوضيحي الخطوة الرقم

يساوي طول ضلعه  بحيث  د(  )أ ب ج  المعين  رسم 

قطُْر الدائرة التي يراد رسمها. 

1

فين لأضلاع المعين. رسم المستقيمين المُنصِّ 2

رسم القطُْر الأكبر )أ ج(. 3

رسم خطين من النقطة )ب(، أو من النقطة )د(، بحيث 

فات الضلعين المقابلين، ويتقاطعان  يصلان إلى مُنصِّ

مع القطُْر )أ ج( في النقطة  )م ( والنقطة )ل(.  

4

مركزين  تمُثِّلان  )ل(  )م(  النقطتين  أن  بافتراض 

للدائرتين، يرُسَم منهما الأقواس الصغيرة التي تمس 

ضلعي المعين.
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يبُين الشكل )4-17( رسم الدائرة بالطريقة التقريبية في المساقط الثلاثة.

الرسم التوضيحي الخطوة الرقم

مركزين  تمُثِّلان  )د(  )ب(  النقطتين  أن  بافتراض 

تمس  التي  الكبيرة  الأقواس  منهما  يرُسَم  للدائرتين، 

ضلعي المعين، وتكُمِل الدائرة. 

6

مسح الأجزاء غير الضرورية كلها باستثناء الأقواس 

الكبيرة والأقواس الصغيرة، فتنتج الدائرة. 

7

الشكل )4-17(: رسم الدائرة بالطريقة التقريبية في المساقط الثلاثة.

اتجاه النظر المسقط الأفقي

اتجاه النظر المسقط الجانبياتجاه النظر المسقط الأمامي
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نشاط 

أرَسُم دائرة بالطريقة التقريبية من جهة اليسار.
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المثال )4( 

أرَسُم الأسطوانة المُبيَّنة في الشكل الآتي بطريقة المنظور الآيزومتري.

خطوات التنفيذ

الرسم التوضيحي الخطوة الرقم

قاعدته  مستطيلات  متوازي  رفيعة  بخطوط  الرسم 

مربعة، وضلعه يساوي قطُْر قاعدة الأسطوانة.

1

رسم الدائرة التي تمُثِّل شكلًا بيضوياًّ في مسقط أفقي 

داخل القاعدة العلوية بالطريقة السابقة نفسها. 

2

تكرار خطوات رسم الدائرة نفسها في القاعدة السفلية. 3
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الرسم التوضيحي الخطوة الرقم

في  الدائرتين  بين  مماسين  عموديين  خطين  وصل 

القاعدتين: العلوية، والسفلية.

4

مسح الخطوط المساعدة، فتنتج الأسطوانة. 5
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التمرين )9(

أرَسُم المنظور الآيزومتري المُبيَّن في الشكل الآتي باستعمال مقياس الرسم )1:1(.
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  الشكل )28(: رسم الأسطوانة في المنظور الآيزومتري.

مات من مواد مختلفة عمل مُجسَّ رابعًا

تتطلَّب بعض الأعمال الهندسية في القطاع الصناعي أحياناً إعادة تشكيل المنظور؛ أي تحويل المنظور 
المرسوم على لوحة الرسم إلى مُجسَّم مادي ملموس بشكله الحقيقي باستعمال مقياس رسم مناسب؛ بغية 
محاكاة العملية الصناعية أو العملية البنائية، وذلك باستعمال العديد من الأدوات والتجهيزات. ويمكن إعادة 
ن الرئيس الذي يسُتعمَل في بناء هيكل المُجسَّم، مثل: الجبس، والورق،  تشكيل المنظور عن طريق المُكوِّ

والكرتون، والخشب، والبلاستيك، والفلين، والإسفنج، والمعجون، والبولسترين.

تخُتار المادة التي يراد صنع المُجسَّم منها بناءً على الهدف المنشود منها؛ إذ يسُتعمَل الورق والكرتون 
للمُجسَّمات التعليمية، ويسُتعمَل الخشب في المُجسَّمات التي تصُنعَ بوصفها تحُفاً.

ح الشكل )4-18( بعض المُجسَّمات المصنوعة من مواد مختلفة.  ويوُضِّ

الشكل )4-18(: مُجسَّمات مصنوعة من مواد مختلفة.

يعَُدُّ تشكيل المُجسَّمات من الورق المقوّى والكرتون من أكثر الطرائق انتشارًا وشهرة؛ً نظرًا إلى سهولة 
توافر الورق المقوّى والكرتون، وتوافر الأدوات اللازمة لعملية التشكيل، وقدرة الطلبة على استعمال هذه 

الطريقة لبناء المُجسَّمات التي يرغبون فيها.

ح إحدى  يمكن تشكيل المُجسَّم بالورق والكرتون عن طريق الثني، أو القص واللصق. والمثال الآتي يوُضِّ
طرائق إنشاء المُجسَّم.
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60

5050
70

تبدأ عملية تشكيل المُجسَّم بتخيُّل تصميمه الواقعي من حيث الأبعاد والمساحات، ويمكن استعمال مقياس 
رسم غير مُحدَّد، أو مقياس رسم أصغر.

المثال )5(

أشُكِّل الصندوق المُبيَّن في الشكل الآتي عن طريق الثني، مُستعمِلًا الورق المقوى أو الكرتون.

المواد والأدوات

مقص، قلم رصاص، مسطرة، مشرط، ورق مقوّى أو كرتون، شريط لصق، صمغ.

خطوات التنفيذ

الرسم التوضيحي الخطوة الرقم

أو  المقوّى  الورق  على  الستة  الصندوق  أوجه  رسم 

الكرتون، بحسب الأبعاد المعطاة، وافتراض أن الوجه 

السفلي )6( هو القاعدة الأساسية.

1

ثني المستوى الأمامي )1(، والمستوى الخلفي )4(؛ 

ليتعامدا مع المستوى السفلي )6(.

2
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الرسم التوضيحي الخطوة الرقم

ثني المستوى الجانبي الأيمن )5(، والمستوى الجانبي 

الأيسر )2(؛ ليتعامدا مع المستوى السفلي )6(.

3

المستويات  مع  ليتعامد  )3(؛  الأفقي  المستوى  ثني 

كلها، ويتوازى مع المستوى السفلي )6(.

4

60

5050
70

60

5050
70

المثال )6(

أو  المقوى  الورق  مُستعمِلًا  واللصق،  القص  طريق  عن  الآتي  الشكل  في  المُبيَّن  الهرم  مُجسَّم  أشُكِّل 
الكرتون.
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الرسم التوضيحي الخطوة الرقم

الكرتون،  أو  المقوّى  الورق  على  الهرم  قاعدة  رسم 

وليكن طول ضلع الهرم )60mm( مم.

1

رسم مثلث متساوي الساقين على كل ضلع من أضلاع 

مم،   )60mm( المثلث  ضلع  طول  وليكن  القاعدة، 

وزاوية القاعدتين )60°(.

2

خارج  تقع  التي  الشكل  من  الخارجية  الأجزاء  قص 

حدود المثلثات الأربعة وأطرافها.

3

لصق أطراف المثلثات السفلية بقاعدة الهرم المربعة، 

ثم لصق الجوانب المثلثية حتى تلتقي جميعًا في نقطة 

تسُمّى رأس الهرم.

4

المواد والأدوات

مقص، قلم رصاص، مسطرة، مشرط، ورق مقوّى أو كرتون، شريط لصق، صمغ.

خطوات التنفيذ
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ر أُفكِّ

كيف أشُكِّل مُجسَّم أسطوانة قطُْرها )50mm( مم كما في الشكل الآتي؟
أتَذكَّر

 π × محيط الدائرة = القطُْر

ø50

120

التمرين )10(

أشُكِّل المُجسَّم المُبيَّن في الشكل الآتي باستعمال طريقة مناسبة.

6045

15

15

20

20

15

20
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الإثراء والتوسع

الشبكة  في  أبحث  ثم  أنواعها،  وجميع  للمناظير  الرئيسة  الأقسام  يبُيِّن  الذي  الآتي  الشكل  أتَأمَّل   –
العنكبوتية عن بقية الأنواع وأقسامها.

أنواع المناظير

المناظير المركزيةالمناظير المتوازية

الإسقاط الهوائيالإسقاط المتعامد الإسقاط المائل

قياس المحورالمتعدد الأوجه

الإسقاط الخطي

ثلاث نقاط

نقطتان

نقطة واحدة الهوائي

العام 

القصير 

الطويل

المنظور الترايمتري

المنظور الدايمتري

المنظور الآيزومتري

إسقاط الزاوية الثالثة

إسقاط الزاوية الثانية

إسقاط الزاوية الرابعة

إسقاط الزاوية الأولى

– قم بالتعاون مع زملائك ببناء المجسم في الشكل المجاور بأسهل 
الطرائق وأقل التكاليف، واعرضه على المعلم.
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القياس والتقويم

يمكنني بعد دراسة هذه الوحدة أن: 

جيد في حاجة إلى التحسين ممتاز مؤشر الأداء الرقم

ح مفهوم الرسم ثلاثي الأبعاد. أوُضِّ 1

ف محاور الرسم ثلاثي الأبعاد.  أتَعرَّ 2

ف مستويات الرسم ثلاثي الأبعاد. أتَعرَّ 3

د أنواع الرسم ثلاثي الأبعاد. أحُدِّ 4

أقَرأ الرسوم ثلاثية الأبعاد. 5

ف المنظور المركزي، والمنظور المتوازي.  أعُرِّ 6

أرَسُم المناظير الجبهية، والمناظير الآيزومترية. 7

أرَسُم المناظير الآيزومترية التي تحوي سطوحًا مائلةً. 8

أرَسُم منظور الدائرة بالطريقة التقريبية. 9

أرَسُم المناظير الآيزومترية التي تحوي سطوحًا أسطوانيةً. 10

أضَع الأبعاد على المناظير بصورة صحيحة. 11

ف مفهوم تشكيل المُجسَّمات. أعُرِّ 12

طريقتي  باستعمال  المناظير  بعض  تحاكي  مُجسَّمات  أعَمل 
الثني والقص.

13
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التمرين الأول
تمارين الوحدة

أمام كل منظور في ما يلي خمسة مساقط مختلفة. أخَتار المسقط الصحيح لإكمال الجدول الآتي:

المسقط الأفقيالمسقط الجانبيالمسقط الأماميرقم المنظور
1

2

3

1

2

 ) أ (

 ) أ (

 ) ب (

 ) ب (

 ) جـ (

 ) جـ (

 ) د (

 ) د (

 ) هـ (

 ) هـ (
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3

 ) هـ ( ) د ( ) جـ ( ) ب ( ) أ (

التمرين الثاني 

أرَسُم المناظير الآيزومترية الآتية باستعمال مقياس الرسم )2:1(.
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التمرين الثالث 

1 - أرَسُم المنظور الآيزومتري الآتي باستعمال مقياس الرسم )1:4(.  

2 - أرَسُم المنظور الآيزومتري الآتي باستعمال مقياس الرسم )3:1(.
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التمرين الرابع

أرَسُم المناظيرالآتية باستعمال مقياس الرسم )1:1(.
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مدخل إلى القطاعات

 لماذا قطُِع المنظور في الشكل؟	 

 كيف يمكن لقطاعات المساقط أن تنُمّي مهارتي التفكير والتخيُّل لدينا؟	 

الوحدة الخامسة



ف القطاعات ودورها في توضيح الأجزاء  تتناول هذه الوحدة المهارات الأساسية والرئيسة اللازمة لتعرُّ
ق فهم الرسم، والتدرب على رسم قطاعات لأجزاء  المختلفة، والتخلص من الخطوط المتشابكة التي تعُوِّ

ميكانيكية، فضلًا عن عرضها لمفاهيم خاصة بالقطاعات.

يتُوقَّع من الطالب بعد دراسة هذه الوحدة أن:

ف مفهوم القطاعات.	  يعُرِّ

ف أهداف القطاعات.	  يتعرَّ

يطُبِّق قواعد التهشير عند تنفيذ الرسوم.	 

د أنواع القطاعات في الرسم.	  يحُدِّ

يرسم القطاعات المختلفة.	 

50



515151

 استكشف

انظر وتساءل 

ما الشروط اللازم اتباعها عند عملية رسم منظور قطُِع من المنتصف؟ وما أسماء الأجزاء الناتجة 
من ذلك؟ وما نوع الخط الذي يعُبر عن القطع؟ 

ماذا نسمي الأجزاء المقطوعة من المنظور؟

ماذا يحدث إذا أحضرنا منشارًا وقمنا بقطع المنظور الموجود في الشكل المجاور؟ 
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مفهوم القطاع أولًا

القطاع هو عملية تخيلية لجسم )المنظور( يراد بها بيان تفاصيل الجسم وأجزائه الداخلية، التي ل تظهر 
للعين عند النظر إليها، ويصعب مشاهدتها، مثل: الثقوب، والتجاويف، والمجاري المختلفة. وفيها تسُتعمَل 

أداة قطع تمر بالمنظور عند مستوى معين يسُمّى مستوى القطع.

يفصل مستوى القطع جزءًا من المنظور؛ ليتمكن الناظر من مشاهدة تفاصيل المنظور الداخلية، وينتج 
من ذلك آثار على سطوح الأجزاء المقطوعة، تمُثَّل بخطوط التهشير.

بخطوط  القطع  آثار  وتمثيل  القطع،  تخيُّل عملية  بعد  المقطوع  للمنظور  العمودي  الإسقاط  يمكن رسم 
التهشير؛ إذ يرُسَم على شكل مسقط يسُمّى القطاع، أنظر الشكل )1-5(.

الشكل )5-1(: منظور قطاع أمامي.
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أهداف القطاعات ثانيًا

هناك أجسام معقدة تحوي كثيرًا من الثقوب والفتحات والنحناءات. وعند رسم هذه الأجسام على شكل 
منظور أو مسقط تتداخل خطوطها، ويصعب تمييزها. 

يمكن إجمال أهداف القطاعات في ما يأتي:

1- إظهار تفاصيل المنظور الداخلية على نحوٍ أكثر وضوحًا.

2- تسهيل قراءة الرسوم؛ بالتقليل من الخطوط الكثيرة المتشعبة، ول سيمّا المتقطعة منها.

3- الستغناء عن المساقط في توضيح المنظور.

يبُيِّن الشكل )5-2( منظورًا قطُِع بمستوى قطع كامل.

الشكل )5-2(: منظور قطاع كامل.
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خطوط القطع ودلالتها ثالثًا

عند  ويكُتبَ  مم،   )0.5( منهما  كل  سُمْك  بخطين،  ينتهي طرفه  القطع هو خط محوري   خط مستوى 
طرفيه حرفان أبجديان متشابهان بجانب سهمين يشيران إلى اتجاه إسقاط القطعة )اتجاه النظر بعد عملية 
القطع(. يسُتعمَل خط القطع للدللة على مستوى القطع، ويمُثِّل الجزءُ الذي خلف السهمين الجزءَ المزال من 

المنظور، ويطُلقَ على المسقط المقطوع السم نفسه، مثل قطاع )ب-ب(.

ح خط القطع. يمُثِّل الشكل )5-3( رسمًا يوُضِّ

الشكل )5-3(: منظور قطاع جانبي.

الشكل )4-5(.

مسقط أماميقطاع جانبي

ب
 أمامي

مسقط
مسقط جانبي

ب

المسقط  إلى  الأسهم  اتجاه  ويشير  الأمامي،  المسقط  على  أ(   - )أ  القطع  خط  فيبُيِّن   )4-5( الشكل  أمّا 
الجانبي؛ ما يدل على ظهور أثر القطع في المسقط الجانبي.

أ

أ
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وأمّا الشكل )5-5( فيبُيِّن خط القطع )أ - أ( على المسقط 
الأمامي، ويشير اتجاه الأسهم إلى المسقط الأفقي؛ ما يدل 

على ظهور أثر القطع في المسقط الأفقي.

الشكل )5-5(.

الشكل )6-5(.

في حين يبُيِّن الشكل )5-6( خط القطع )ب-ب( على 
المسقط الأفقي، ويشير اتجاه الأسهم إلى المسقط الأمامي؛ 

ما يدل على ظهور أثر القطع في المسقط الأمامي.

مسقط أمامي

قطاع أفقي

أ أ

قطاع أمامي

مسقط أفقي

بب

قطاع أمامي

مسقط أفقي

بب
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خطوط التهشير رابعًا

عند رسم القطاعات لمنظور ما، فإن السطوح التي يمرُّ بها خط القطع تهُشَّر بخطوط متوازية رفيعة، 
ترُسَم بقلم خفيف، وبزاوية تميل على المحور الأفقي بمقدار )°45(، وتتراوح المسافة بينها بين )2–4( مم، 
وذلك حسب مساحة السطح المراد تهشيره، ويبلغ سُمْكها )0.4( مم. يستفاد من خطوط التهشير في تمييز 

سطوح الرسم المقطوعة من بقية سطوح أجزاء الرسم.

في ما يأتي القواعد الخاصة بعملية التهشير:

1- رسم السطوح المقطوعة للجزء الواحد في المسقط الواحد بخطوط تميل باتجاه واحد، وبمسافة تباعد 
واحدة كما في الشكل )7-5(.

الشكل )5-7(: تهشير جسم واحد.

2- في حال وجود جسمين، وحدوث عملية قطع لهما، يعُكَس اتجاه التهشير كما في الشكل )8-5(.

الشكل )5-8(: تهشير جسمين.
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ر عند قطعها الأجزاء التي لا تُهشَّ خامسًا

يهدف رسم القطاع بصورة رئيسة إلى إظهار التشكيل الداخلي للجسم بخطوط واضحة؛ تسهيلًا لعمليات 
التنفيذ في المشاغل وعمليات الصيانة. غير أن هناك بعض القطع المصمتة، مثل المحاور والأعصاب التي 
ل يستفاد من قطعها. وقد اتُّفقِ على عدم قطع بعض الأجزاء الميكانيكية في الرسم الهندسي، كما في الجدول 

)5-1( الذي يبُيِّن الرسم الصطلاحي لبعض الأجزاء التي ل تهُشَّر عند قطعها.

الرسم في حالة القطاعالجزء الذي لا يهُشَّر

البراغي.

الصواميل.

أسنان التروس.

ب

ب

مسقط أمامي قطاع جانبي

الجدول )5-1( الأجزاء التي ل تهُشَّر عند قطعها
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أنواع القطاعات سادسًا

الرسم في حالة القطاعالجزء الذي لا يهُشَّر

إذا كان مستوى خط القطع موازياً لسطح 

كما  تهُشَّر  ل  الأعصاب  فإن  العصب، 

في القطاع )أ - أ(.

إذا كان مستوى خط القطع عمودياًّ على 

العصب، فإن الأعصاب تهُشَّر كما في 

القطاع )ب-ب(.

أ

أ

قطاع أمامي

ب

قطاع جانبي

ب

تحتوي الأجسام الهندسية في داخلها على تفاصيل وأجزاء مهمة غير مرئية؛ لذا يجب توضيحها بعمل 
قطاعات لها؛ إذ يمكن تخيل أجزائها الداخلية بعد نزع الأجزاء المقطوعة منها، ثم رسمها بعد قطعها.

توجد أنواع مختلفة من القطاعات يمكن تمييز بعضها من بعض بالنظر إلى مستوى القطع، وهذه القطاعات هي:

1- القطاع الكامل

القطاعات شيوعًا، ويغلب استعماله في حال كان الجسم غير متماثل،  أنواع  الكامل أكثر  القطاع  يعَُدُّ 
وذلك بقطعه كاملًا في مستوى قاطع واحد؛ شرط أن يكون القطاع موازياًّ لأحد مستويات إسقاط الجسم. 
فإذا كان مستوى القطع موازياً لمستوى الإسقاط الأمامي، أطُلقِ على القطاع اسم القطاع الأمامي. وإذا 
كان مستوى القطع موازياً لمستوى الإسقاط الأفقي، أطُلقِ على القطاع اسم القطاع الأفقي. أمّا إذا كان 
مستوى القطع موازياً لمستوى الإسقاط الجانبي فإن القطاع يسُمّى القطاع الجانبي. أنظرُ الشكل )9( 

الذي يمُثِّل قطاعًا أمامياًّ كاملًا.
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الشكل )5-9(: قطاع أمامي كامل.

يمُثِّل الشكل )5-10( قطاعًا أفقياًّ كاملًا )جـ-جـ(، وقطاعًا جانبياًّ كاملًا )ب-ب(.

الشكل )5-10(: قطاع أفقي كامل وقطاع جانبي كامل.
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2- نصف القطاع

يستخدم هذا النوع من القطاعات في الأجسام المتماثلة لإظهار أجزاء الجسم الخارجية والداخلية معًا. 
ويمُثِّل الشكل )5-11( نصف القطاع الأمامي، ونصف القطاع الجانبي لمنظور.

الشكل )5-11(: نصف القطاع الجانبي، ونصف القطاع الأمامي لمنظور.

40

25

10 15 10 30 10

40

3- القطاع الجزئي

يستخدم هذا النوع من القطاعات لإظهار بعض الأجزاء الموجودة داخل الأجسام المصمتة، ويكتفى فيه 
بتحديد مكان القطاع الجزئي بخط يدوي رفيع يسُمّى خط الكسر، وتهُشَّر المنطقة الواقعة داخل القطاع 

فقط، أنظر الشكل )12-5(.

الشكل )5-12(: قطاع جزئي.
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4- قطاع المحاذاة

المحور  إلى  بالنسبة  ما  زاوية  على  مُركَّب  جسم  من  جزء  لتوضيح  القطاعات  من  النوع  هذا  يستخدم 
الرئيس، أو في حال عدم وقوع الأجزاء المراد إظهارها على خط محوري مستقيم كما في الشكل )13-5(.

الشكل )5-13(: قطاع المحاذاة.

5- القطاع المدار

ر في هذا القطاع الجزء المقطوع حول محور الدوران بزاوية مقدارها )90º(، ثم يرُسَم على المسقط  يدُوَّ
في مكان الدوران نفسه كما في الشكل )14-5(.

الشكل )5-14(: القطاع المدار.

مسقط أفقي

أ

أقطاع محاذاة
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6- القطاع المتنقل

يستخدم هذا النوع من القطاعات عندما يكون محور القطع متغير التجاه، ويمر بمستويات عِدَّة لإظهار 
أجزاء داخلية للحصول على أكبر إيضاح ممكن للمُجسَّم، كما في الشكل )15-5(.

الشكل )5-15(: القطاع المتنقل.
7- القطاع المزال

يرُسَم هذا النوع من القطاعات لتوضيح جزء معين من الجسم بعد قطعه، ويرُسَم هذا الجزء منفصلًا 
باتجاه موازٍ لمستوى القطع، أو في أيِّ موضع آخر مناسب كما في الشكل )16-6(.

الشكل )5-16(: القطاع المزال.

أ

أ

أ

أ
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المثال )1(

يمُثِّل الشكل الآتي منظورًا لجسم ما، ويمُثِّل الشكل الآخر قطاعًا أمامياًّ للمنظور عند )أ – أ(. 
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المثال )2(

يمُثِّل الشكل الآتي منظورًا لجسم ما، ويمُثِّل الشكل الآخر قطاعًا جانبياًّ للمنظور عند )ب– ب(. 
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المثال )3(

يمُثِّل الشكل الآتي منظورًا لجسم ما، ويمُثِّل الشكل الآخر قطاعًا أفقياًّ للمنظور عند )جـ – جـ(. 
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يمكنني بعد دراسة هذه الوحدة أن: 

 فــي حاجــة إلــى
التحســين جيد ممتاز مؤشر الأداء الرقم

ف مفهوم القطاع. أعُرِّ 1

أمُيِّز مستويات القطع ودللتها. 2

أمُيِّز خط القطع ودللته. 3

ف مواصفات خطوط التهشير. أتَعرَّ 4

أرَسُم خطوط التهشير. 5

أضَبط المسافات بين خطوط التهشير. 6

د الأجزاء التي ل تهُشَّر عند قطعها. أحُدِّ 7

د أنواع القطاعات. أعُدِّ 8

د العلاقة بين المسقط والقطاع. أحُدِّ 9

أرَسُم القطاع الأمامي الكامل للمناظير. 10

أرَسُم القطاع الجانبي الكامل للمناظير. 11

أرَسُم القطاع الأفقي الكامل للمناظير. 12

ف عمليات القطع مستعيناً بالمراجع المختلفة، مثل الشبكة العنكبوتية. أتَعرَّ 13

القياس والتقويم

الإثراء والتوسع

ابحث مع زملائك في شبكة النترنت وفي مصادر المعرفة الأخرى عن أنواع أخرى من القطاعات 
واكتب تقريرًا عنها، وناقشه تحت إشراف المعلم.
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الشكل )17/ أ(: المنظور الآيزومتري.

التمرين الأول

التمرين الثاني

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- القطاع الأمامي )أ - أ(.

2- القطاع الجانبي )ب-ب(.

3- المسقط الأفقي.

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- القطاع الأمامي )أ - أ(.

2- القطاع الجانبي )ب- ب(.

3- المسقط الأفقي.
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التمرين الثالث

التمرين الرابع

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- القطاع الأمامي )أ - أ(.

2- القطاع الجانبي )ب- ب(.

3- المسقط الأفقي.

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- المسقط الأمامي.

2- المسقط الجانبي.

3- القطاع الأفقي )جـ - جـ(.

10

40

10

30

40

10
15

10

50

30

40

10

R 10

40

30

60

مسقط جانبي
أمامي

مسقط 

44

45

43

12
.5

33
12

.5
58

R 10

R 10

22

15

12
.5

33

أمامي
مسقط 

مسقط جانبي



69

التمرين الخامس

التمرين السادس

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- القطاع الأمامي )أ - أ(.

2- المسقط الجانبي.

3- المسقط الأفقي.

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- المسقط الأمامي. 

2- القطاع الجانبي )ب– ب(.

3- المسقط الأفقي.
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التمرين السابع

التمرين الثامن

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- المسقط الأمامي.

2- القطاع الجانبي )ب- ب(. 

3- المسقط الأفقي.

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- المسقط الأمامي.

2- القطاع الجانبي )ب- ب(. 

3- المسقط الأفقي.
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التمرين التاسع

التمرين العاشر

يمُثِّل الشكل المجاور قطعة ميكانيكية.

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- القطاع الأمامي )أ - أ(.

2- المسقط الجانبي.

3- المسقط الأفقي.

يمُثِّل الشكل المجاور قطعة ميكانيكية

أرَسُم باستعمال مقياس الرسم )1:1( ما يأتي:

1- القطاع الأمامي )أ - أ(.

2- القطاع الجانبي )ب- ب(. 

3- المسقط الأفقي. 
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4-5

4-7

6-1 4-326-26-3

4-32

6-4

6-5

+
+

6-66-76-86-96-1011-12

الرسم الحــر

الرسم باليد الحرة هو الطريقة الأساسية للتعبير المبدئي عمّا يجول في أذهان المصممين. أفُسِّر ذلك.	 

أنُاقش زملائي في المقولة الآتية: "الرسم الحر موهبة وملكة فنية تولد مع الإنسان." 	 

الوحدة السادسة
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الرسم  أدوات  واستعمال  المكتب  وجود  دون  من  مكان  أيِّ  في  سريعًا  تنفيذها  يمكن  لغة  الحر  الرسم 
الهندسي؛ فهي تحتاج فقط إلى قلم رصاص، وممحاة، وورقة؛ ما يساعد على رسم الفكرة في لحظتها، ثم 

تطويرها لرسمها بشكلها النهائي، ثم تنفيذها.

أهـداف الرسم الحر

للرسم الحر أهداف عِدَّة، أهمها:

1 - رسم الفكرة في لحظتها. 

2 - شرح الفكرة لأصحاب العلاقة في الموقع أو الميدان.

3 - تحديد الأبعاد على أرض الواقع.

4 - توفير الوقت، وسرعة الإنجاز.

5 - سهولة التعديل وصولً إلى الهدف المطلوب.

يتُوقَّع من الطالب بعد دراسة هذه الوحدة أن:

ف مفهوم الرسم الحر.	  يعُرِّ

ف أهداف الرسم الحر.	  يتعرَّ

ف الخطوط في الرسم الحر، وطريقة رسمها.	  يتعرَّ

يتعرَّف طرائق رسم الدوائر والأقواس والأشكال البيضوية.	 

يرسم مُجسَّمات ومساقط من واقع نماذج حقيقية.	 
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 استكشف

انظر وتساءل 

طلب مالك المنزل من أحد النجارين تصميم خزانة حائطية في أحد زوايا المنزل، فقام النجار برسم 
نموذج بيده دون استخدام أدوات الرسم الهندسي. هل ما قام به النجار صحيح؟ برّر إجابتك.

ما طريقة الرسم التي رُسِم بها الشكل أدناه؟ وهل هذه الطريقة تعدُّ من الطرائق المعتمدة في الرسم 
الهندسي؟
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رسم القطع المستقيمة أولًا

لرسم الخطوط المستقيمة، يجب اللتزام بالأسس التي تفُْضي إلى الدقة والوضوح في عملية الرسم، ومن 
أهم هذه الأسس:

1 - استعمال قلم رصاص رفيع لتسهيل عملية المحي، والتعديل، وعدم ترك أثر في ورقة الرسم. 

2 - مسك القلم على نحوٍ يريح اليد، وعدم ضغطه بين الأصابع، كما في الشكل )1-6(. 

3 - عدم الضغط بشدة على ورقة الرسم.

4 - تحديد نقطتي البداية والنهاية عند رسم الخط المستقيم. وفي حال كان 
البداية ونقطة  نقطة  بين  النقاط  نسبياًّ، يوضع عدد من  الخط طويلًا 

النهاية على الستقامة نفسها. 

اليمين، بحيث يمكن رؤية  إلى  اليسار  البدء برسم الخط الأفقي من   - 5
رأس القلم في أثناء عملية الرسم، كما في الشكل )2-6(.

6 - رسم خطوط خفيفة قصيرة، وعدم رسم الخط كله في شوط واحد.

7 - رسم الخط الرأسي بدءًا من الأعلى باتجاه الأسفل، كما في الشكل )3-6(.

8 - تثبيت ساعد اليد والرسغ، وتحريك الأصابع في أثناء عملية الرسم. 

9 - تحريك الورقة في أثناء عملية الرسم بما يناسب اليد.

الشكل )1-6(.

الشكل )2-6(.
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الشكل )3-6(.

اقرأ وتعلم
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رسم الدوائر ثانيًا

في ما يأتي الخطوات الواجب اتباعها عند رسم دائرة:

1 - رسم محورين متعامدين يتقاطعان في نقطة المركز. 

2 - تحديد أربع نقاط على خطي المحور ضمن مسافات متساوية في طول نصف قطُْر الدائرة المراد رسمها.

3 - رسم خطيَّ محور آخريْن من نقطة المركز، مائليْن بزاوية )°45( عن المحورين السابقين.

4 - تحديد أربع نقاط أخرى متساوية من حيث طول نصف القطُْر، كما في الشكل )4-6(.

الشكل )4-6(.

5 - رسم أقواس صغيرة عند نهايات أنصاف الأقطار المرسومة، كما في الشكل )5-6(.

الشكل )5-6(.

6 - وصل الأقواس بعضها ببعض، فتنتج الدائرة المطلوبة، كما في الشكل )6-6(.

الشكل )6-6(.
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رسم الأقواس ثالثًا
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ترُسَم الأقواس بطريقة رسم الدوائر نفسها؛ إذ يعَُدُّ القوس جزءًا من الدائرة. وفي ما يأتي خطوات رسم 
الأقواس:

1 - رسم خطين متعامدين على شكل زاوية قائمة.

فاً الزاوية القائمة. 2 - رسم خط مائل مُنصِّ

3 - تحديد ثلاث نقاط تبعد عن نقطة المركز بمقدار نصف قطُْر القوس المراد رسمه، كما في الشكل )7-6(.

الشكل )7-6(.

4 - رسم أقواس صغيرة عند نهايات أنصاف الأقطار، كما في الشكل )8-6(.

الشكل )8-6(.

5 - وصل الأقواس بعضها ببعض، فينتج الشكل المطلوب، كما في الشكل )9-6(.

الشكل )9-6(.
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رسم الأشكال البيضوية رابعًا

في ما يأتي خطوات رسم الشكل البيضوي:

1 - تحديد خطيَّ محور متعامدين.

2 - تحديد أربع نقاط بمقدار القطُْر الأصغر والقطُْر الأكبر، كما في الشكل )10-6(.

الشكل )10-6(.

3 - رسم أقواس صغيرة عند نهايات أنصاف الأقطار، كما في الشكل )11-6(.

الشكل )11-6(.

4 - توصيل الأقواس بعضها ببعض، فينتج الشكل المطلوب، كما في الشكل )12-6(.

الشكل )12-6(.
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رسم المناظير الهندسية خامسًا

1 - رسم مكعب

في ما يأتي خطوات رسم مكعب باليد الحرة:

أ   - رسم خط أفقي قصير مستقيم.

ب - تنصيف الخط الأفقي بنقطة.

جـ - رسم خط رأسي متعامد على الخط الأفقي.

د  - رسم قوس صغير مركزه نقطة التقاء الخط الرأسي بالخط الأفقي؛ 
على أن يكون متساوياً في بعُْد طرفيه عن نقطة المركز.

هـ - تقسيم القوس ثلاثةَ أقسام متساوية، بوضع نقطتين على القوس.
أنظرُ الشكل )6-13/ أ(. 

و - وصل نقطة المركز بالنقطة الأولى على القوس فوق الخط الأفقي. 

ز - مَدُّ الخط بطول ضلع المكعب المراد رسمه، فتنتج زاوية مقدارها 
)°30( مع الخط الأفقي. 

ح - تكرار الخطوات السابقة نفسها بعمل خط بزاوية )°30(، مماثلًا 
لطول الخط السابق من الجهة الأخرى، أنظر الشكل )6-13/ ب(.

ط - تحديد طول الخط الرأسي بطول الخطين السابقين نفسيهما، فتنتج 
ثلاثة خطوط أساسية متساوية الأطوال. 

ي - رسم خطين رأسيين من نهاية الخطين المائلين بزاوية )30°(، 
أنظر  الأساسي،  الرأسي  الخط  طول  في  ومتساوين  موازيين 

الشكل )6-13/ جـ(.

الأساسي،  الرأسي  الخط  بنهاية  الرأسية  الخطوط  نهاية  - وصل  ك 
أنظر الشكل )6-13/ د(.

ل - رسم خط موازٍ للخط المائل جهة اليسار، بدءًا بنهاية الخط الرأسي 
جهة اليمين، ورسم خط موازٍ للخط المائل من جهة اليمين بدءًا 

بنهاية الخط الرأسي جهة اليسار، أنظر الشكل )6-13/ هـ(.

الشكل )6-13/ أ(.

الشكل )6-13/ جـ(.

الشكل )6-13/ د(.

الشكل )6-13/ هـ(.
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6-14

6-166-18 6-13

64

6-14

6-166-18 6-13
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6-146-166-18 6-13

64

6-146-166-18 6-13

64

6-14

الشكل )6-13/ ب(.



80

2 - رسم منظور يحتوي على أسطوانة

في ما يأتي خطوات رسم منظور يحوي أسطوانة:

أ   - رسم قاعدة الشكل باتباع خطوات المثال السابق نفسها، أنظر 
الشكل )6-14/ أ(. 

ب - تنصيف وجه القاعدة، ثم رسم خطي محور متعامدين بحيث 
يتقاطعان في نقطة المركز.

جـ - اعتماد نقطة المركز لتحديد طول القطُْر الأكبر وطول القطُْر 
الأصغر بأربع نقاط.

د  - رسم الشكل البيضوي للقاعدة السفلى للأسطوانة، أنظر الشكل 
)6-14/ ب(.

هـ - اعتماد نقطة المركز لرسم خط رأسي بارتفاع الأسطوانة.

و - اعتماد نقطة الخط الرأسي العلوي لرسم خطي محور متوازيين 
ومساويين لخطيَّ محور القاعدة السفلى.

ز - رسم الشكل البيضوي العلوي، أنظر الشكل )6-14/ جـ(.

ح - رسم خطين رأسيين، بدءًا بطرفي الشكل البيضوي العلوي، 
المطلوب،  الشكل  فينتج  السفلي،  البيضوي  بالشكل  وانتهاءً 

أنظر الشكل )6-14/ د(.

6-166-18 6-13

64

6-14
6-166-18 6-13

64

6-14
6-166-18 6-13

64

6-146-166-18 6-13

64

6-14

التمرين )1(

أرَسُم الشكل الآتي باليد الحرة.

الشكل )6-14/ أ(.

الشكل )6-14/ ب(.

الشكل )6-14/ جـ(.

الشكل )6-14/ د(.
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3 - رسم منظور مُركَّب

يحتوي المنظور المُركَّب على سطوح مائلة، وثقوب، 
ومجارٍ داخلية، وسطوح منحنية، أنظر الشكل )15-6( 

الذي يمُثِّل منظورًا هندسياًّ.

في ما يأتي خطوات رسم منظور مُركَّب:

أ   - رسم خط أفقي قصير مستقيم.

ب - رسم خط رأسي قصير متعامد على الخط الأفقي.

جـ - رسم قوس صغير على الزاوية القائمة لخطي التعامد.

د  - تقسيم القوس  ثلاثةَ أقسام متساوية بوضع نقطتين على القوس.

هـ - وصل نقطة المركز بالنقطة الأولى على القوس من جهة الخط الأفقي، ثم مَدُّ الخط على امتداده 
بطول المنظور.

بعرض  خط  ورسم  الثانية،  القائمة  الزاوية  على  قوس  ورسم  نفسها،  السابقة  الخطوات  تكرار   - و 
المنظور، فيميل الخطان بزاوية )°30( عن الخط الأفقي. 

بزاوية   اليسار  على  المائل  والخط  اليمين،  على   )30°( بزاوية  المائل  )الخط  الثلاثة  الخطوط   - ز 
)°30(، والخط الرأسي( هي الخطوط الأساسية التي يمكن بها إكمال رسم المنظور.

ح - إكمال رسم خطوط المنظور بحسب أبعادها، فتكون جميع الخطوط المائلة إلى جهة اليمين موازية 
لخط الأساس، وجميع الخطوط المائلة إلى جهة اليسار موازية لخط الأساس، والخطوط الرأسية 

موازية للخط الرأسي الأساس، أنظر الشكل )6-15/ أ(.

الشكل )15-6(.

الشكل )6-15/ أ(.
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في ما يأتي خطوات رسم الجزء المائل )العصب(:

أ - تحديد نقطة المنتصف لسُمْك العصب على المنظور 
من أعلى، ونقطة المنتصف لسُمْك العصب عند نهاية 

العصب من أسفل.

ب - تحديد نقطتين على يمين نقطة المنتصف ويسارها 
من أعلى، ومن أسفل، بسُمْك العصب، أنظرُ الشكل 

)6-15/ ب(.

جـ - رسم خط رأسي بارتفاع العصب من النقطة اليسرى، 
واعتماد نهاية الخط الرأسي لرسم خط للنقطة اليسرى 

بسُمْك العصب، فينتج خط مائل بزاوية )30°(. 

د - الوصل بين نهاية الخط السفلي وبداية الخط الرأسي 
بخط مستقيم.

هـ - وصل خط بين النقطة اليمنى العلوية والنقطة اليمنى 
أنظرُ  السابق،  للخط  السفلية؛ على أن يكون موازياً 

الشكل )6-15/ جـ(.

6-166-18 6-13

64

6-14

6-166-18 6-13

64

6-14

الشكل )6-15/ ب(.

الشكل )6-15/ جـ(.

نقطة 
المنتصف

ك العصب
سُمْ
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رسم المساقط لمنظور هندسي سادسًا

يمُثِّل الشكل )6-16( منظورًا هندسياًّ. أرَسُم باستعمال مقياس رسم مناسب، وباليد الحرة ما يأتي:
1 - المسقط الأمامي للمنظور.
2 - المسقط الجانبي للمنظور.
3 - المسقط الأفقي للمنظور.

ح الشكل )6-17( رسم المساقط الثلاثة للمنظور باستعمال اليد الحرة. يوُضِّ

الشكل )16-6(.
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التمرين )2(

أرَسُم باستعمال بمقياس رسم مناسب المنظور المُبيَّن في الشكل الآتي، مُستنتجًِا المساقط الثلاثة له.
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الإثراء والتوسع

يمكنني بعد دراسة هذه الوحدة أن: 

إلـى  فـي حاجـة 
لتحسـين ا جيد ممتاز مؤشر الأداء الرقم

ف مفهوم الرسم الحر. أعُرِّ 1

د أهداف الرسم الحر. أحُدِّ 2

أمُيِّز رسم الخطوط في الرسم الحر. 3

أرَسُم الخطوط في الرسم الحر. 4

أرَسُم الدوائر في الرسم الحر. 5

أرَسُم المُجسَّمات في الرسم الحر. 6

أرَسُم المساقط في الرسم الحر. 7

أقَرأ الرسوم والمُخطَّطات في الرسم الحر. 8

القياس والتقويم

أقَف أمام إحدى الآلت في المشغل، ثم أرَسُمها باليد الحرة، ثم أعرضُ الرسم على زملائي.
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تمُثِّل الأشكال الآتية عُدَدًا يدوية:

1 - أذَكر أسماء هذه العُدَد.

2 - أرَسُم باليد الحرة هذه العُدَد.

تمارين الوحدة
التمرين الأول
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التمرين الثاني

أرَسُم باليد الحرة الأشكال والمُخطَّطات الهندسية الآتية، مُستعمِلًا مقياس رسم مناسباً:
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التمرين الثالث

أرَسُم باليد الحرة المناظير الآتية، مُستعمِلًا مقياس رسم مناسباً:
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التمرين الرابع

أرَسُم باليد الحرة المساقط الثلاثة للمناظير الآتية، مُستعمِلًا مقياس رسم مناسباً:
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الرسم باستعمال
الحاسوب

ما أشكال التطور التقني في التعليم؟	 

كيف نواكب التطور التقني العالمي؟	 

الوحدة السابعة



تضمَّنت الإصدارات الأولى لبرنامج )AutoCAD( استعمال أدوات بدائية 
الكتابية.  والدوائر، والأقواس، والنصوص  المتعددة،  بالخطوط، والأشكال  خاصة 
تطبيق  واجهة  بتضمينه  البرنامج  ر  طوُِّ الماضي  القرن  تسعينيات  منتصف  وفي 
النماذج  من  كاملة  مجموعة  تضمينه  فضلًا عن   ،)C++( البرمجة  لغة  باستعمال 
المُجسَّمة الأساسية وأدوات الرسم ثلاثي الأبعاد، ثم حُدِّث البرنامج اليوم، وأدُخِلت 
تحسينات على إصداراته المتتالية؛ ففي إصدار عام 2007م، أصبح إنتاج التصاميم 
ثلاثية الأبعاد عملية سهلة نتيجة إدخال عدد من التحسينات على بيئة الرسم ثلاثي 

الأبعاد.

مجــالت   )AutoCAD( وظائف  شملت  فـقد  اللاحــقة  الإصــدارات  في  أمّا 
تخصصية متعددة، وأضُيفت برامج أخرى، مثل: برنامج التصميم والرسم المعماري 
 AutoCAD( الكهـربـائي التصمـيم  )AutoCAD Architecture(، وبرنـامج 
 ،)AutoCAD Mechanical( الميكانيـكي  التصمـيم  وبرنـامج   ،)Electrical
يعُْنىَ   )AutoCAD Structural Detailing( الإنشائيين  للمهندسين  وبرنـامج 

برسم التفاصيل وإعداد اللوحات الإنشائية.

القطاعات  بحاجات  الوفاء  في  أسهمت  البرنامج  هذا  من  عِدَّة  إصدارات  توجد 
المعلومات الجغرافية،  الهندسية، ونظم  المهن  والشرائح الوظائفية المختلفة، مثل: 
الخدمية  القطاعات  وتطوير  الإنتاجية،  الصناعية  والتخصصات  الخرائط،  ورسم 
)مخططات لشبكات الأنابيب، أو شبكات الطرق، وتطوير الأراضي واستصلاحها، 
من  المعلومات  استخلاص  أيضًا  البرنامج  هذا  مزايا  من  المائية(.  والمشروعات 
صور الأقمار الصناعية، ومن الخرائط والمخططات الهندسية الورقية المدخلة في 

الحاسب بالمسح الضوئي.

في  الإضافية  التطبيقات  من  كبيرًا  عددًا  للبرنامج  الصانعة  الشركة  وفَّرت  لقد 
موقعها الرسمي بالشبكة العنكبويتة للوفاء بحاجات التخصصات الهندسية جميعها، 

ومن ذلك توفير نسخ من البرنامج بلغات عالمية متعددة.
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هناك طريقتان للرسم الهندسي، هما:
1- الطريقة التقليدية

تسُتخدَم في هذه الطريقة أدوات متعددة )مثل: الطاولة، والمسطرة، والمثلثات، والأقلام( لإنتاج الرسوم؛ 
وهي الطريقة التي تعلَّمْتهُا.

)CAD( 2- الطريقة المحوسبة

لعبارة  اختصار  )CAD( هي  الرسوم. والأحرف  الحاسوب لإنجاز  بجهاز  الطريقة  في هذه  يستعان 
)Computer Aided Drawing(، وتعني استعمال الحاسوب في عملية الرسم. تمتاز الطريقة المحوسبة 
برسم أدق التفاصيل لأيِّ شكل بحيث يشُابهِ رسم الواقع الحقيقي، علمًا بأنه يتوافر العديد من برامج الرسم 
بالحاسوب؛ سواء كانت هذه البرامج عامة تنُتجِ معظم الرسوم )الميكانيكية، والكهربائية، والمعمارية، ...( 
مثل برنامج الرسم بالحاسوب )AutoCAD(، أو متخصصة مثل برنامج )Solid Edge( الذي ينُتجِ 

رسومًا ميكانيكية معقدة.

يتُوقَّع من الطالب بعد دراسة هذه الوحدة أن:

ف مفهوم الرسم المحوسب ومزاياه.	  يعُرِّ

 	.)AutoCAD( ف واجهة برنامج الرسم بالحاسوب يتعرَّ

يتعرَّف خصائص البرنامج في الرسم.	 

يمُيِّز بين أدوات الرسم على الحاسوب.	 

يستعمل الشبكة العنكبوتية في قراءة المُخطَّطات.	 
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 استكشف

انظر وتساءل 

 ما البرامج التي يمكن من خلالها رسم الأشكال الهندسية والمناظير والمساقط؟

أهمية  يبيُن  عنها  مفصلًا  تقريرًا  وأكتبُ  الإنترنت،  شبكة  طريق  عن  البرامج  هذه  عن  أبحثُ 
استخدامها في الوقت الحالي.

هل تستطيع رسم المنظور المبين في الشكل 
باستخدام أدوات الرسم الهندسي، وتحصل على 
برنامج  استخدام  عند  نفسيْهما  والإتقان  الدقة 

)AutoCAD(؟



95

اقرأ وتعلم

استعمال برنامج الرسم بالحاسوب )AutoCAD( ومزاياه أولًا

بالحاسوب )AutoCAD(؛ لأن  الرسم  برنامج  الخطوة الأولى لستعمال  اليدوي هو  الهندسي  الرسم 
فقد  للنماذج.  الثلاثية  الأبعاد  ر  الهندسي بصورة صحيحة، وتصوُّ الرسم  اليدوي هو الأساس لأداء  الرسم 
تتعذَّر رؤية النموذج بالعين؛ ما يتطلَّب تكوين صورة خيالية في الدماغ؛ لذا يجب أولً إعداد لوحات الرسم 
الهندسي يدوياًّ قبل استعمال البرامج الهندسية، مثل برنامج الرسم بالحاسوب )AutoCAD(؛ إذ تسُهِم هذه 

ر الأشياء عقلياًّ بالرغم من أهميتها. البرامج في تقليل قدرة الشخص على تصوُّ

)AutoCAD( 1- مزايا برنامج الرسم بالحاسوب

أ  - توفير الوقت، وزيادة الإنتاجية؛ نظرًا إلى سهولة استعمال البرنامج، واشتماله على واجهة سهلة 
الفهم، وتقديمه نظرة أساسية شاملة في ما يخص التصاميم.

ب- القدرة على إعادة استعمال النماذج، وتصحيح الأخطاء بسهولة.

جـ- سهولة الإرسال والستقبال بواسطة البريد الإلكتروني.

د  - توافر أدوات مُحدَّدة لإنشاء الأبعاد الهندسية في البرنامج، ورسم نسيج السطح وتحديد نوعية مادته، 
وتوافر الرموز الميكانيكية وعدد كبير من الرموز المتفق عليها في مجال التخصص.

)AutoCAD( 2- استعمالات برنامج الرسم بالحاسوب

يحرص المهندسون والمصممون والرسامون على استعمال هذا البرنامج في تصاميمهم؛ نظرًا إلى قدرة 
التحتية،  البنية  المعدات، وتخطيط مشروعات  بتصنيع  الخاصة  الهندسية  الرسوم  البرنامج على عمل 
وتصميم الدارات الكهربائية، وبناء المنازل والمباني التجارية، من دون حاجة إلى استعمال المثلثات 

والمساطر التي استعملها المصممون القدامى في الرسم التقليدي المعتمد على قلم الرصاص والورقة.

.)AutoCAD( في ما يأتي بيان لأنواع الرسوم التي يمكن إعدادها باستعمال برنامج الرسم بالحاسوب

أ  - الرسوم ثنائية الأبعاد )2D( )Two Dimension(: الرسوم ثنائية الأبعاد من أشهر الرسوم استعمالً في 
برنامج الرسم بالحاسوب )AutoCAD(، وهي رسوم ثنائية الأبعاد خاصة بالصناعات، والفضاء، 
والهندسة المعمارية، وتصميم السيارات، والخرائط، والتصميم الداخلي، وتصميم الحدائق، وعالم 

الموضة والأزياء.
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ب- الرسوم ثلاثية الأبعاد )3D( )Three Dimension(: تمتاز الرسوم ثلاثية الأبعاد بتقديم مزيد من 
التفاصيل للعناصر الفردية والمكونات المجتمعة بعضها مع بعض؛ أي بيان كيف تتناسب الأبعاد 

بعضــها،  مـع  وتعـمل  مـعًا،  وتترابـط 
ويكُمل كلٌّ منها الآخر بدلً من وصف 
حجمها، فضلًا عن تقـديم نـظرة عـامة 

عن شكلها الإجمالي.

قـد ل تسُتعمَل هـذه الرسـوم في رســم 
الرسـوم  إن  إذ  الأرضية؛  المخططات 
ثنائية الأبـعاد تـفي بالغـرض. أمّـا في 
نموذج  فيسُتعمَل  الميكانيكية  الهـندسة 
المعـقدة  القـطـع  لرسـم  الأبـعاد  ثـلاثي 
وتـجسـيدهـا في مـا يـخـص صــناعـة 
المخــتلفة،  الســـيارات، والصــناعات 
وبيان كيفية تداخلها وترابط بعضها مـع 
واضـحة  صــورة  يعـطي  مـا  بعـض؛ 

شاملة عن المُجسَّم الكلي.

الشكل )7-2(: نموذج لرسم ثلاثي الأبعاد.

الشكل )7-1(: نموذج لرسم ثنائي الأبعاد.

فالخطوة الأولى لبناء أيِّ منزل أو مشروع 
– مثلًا – هي التخـطـيط، ورسـم نمــوذج 
توضيحي دقيق لفراغات المشروع. وفـيها 
يعُبِّر المهندس المعماري عن أفكاره في 
الرسم  برنامج  باستعمال  ورقة مرسومة 
بالحاسوب )AutoCAD(، فيظهر رسم 
ثنائي الأبعاد لأرضية المشروع، وبعض 
على  البرنامج  هذا  ويساعد  تفاصيله، 

تنفـيذها، أنظر الشكل )1-7(.
Ø
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التمرين )1(

أقُارِن بين الرسم اليدوي التقليدي والرسم باستعمال الحاسوب كما في الجدول الآتي:

الرسم باستعمال الحاسوب الرسم اليدوي التقليدي وجه المقارنة

أدوات الرسم:

زمن الإنجاز:

إمكانية التعديل:

سرعة الإنجاز:

الدقة والإتقان:

تشغيل البرنامج وواجهة المستخدم ثانيًا

1- تشغيل البرنامج

يمكن تشغيل البرنامج من واجهة المستخدم الرئيسة في جهاز الحاسوب، وذلك باختيار الأيقونة الخاصة 
بالبرنامج التي تمُثِّل شعار البرنامج، وتظهر بحرف )A( باللون الأحمر كما في الشكل )7-3(، فتظهر 

الشكل )7-3(: تشغيل برنامج الرسم باستعمال الحاسوب.

AutoCAD الأيقونة الخاصة ببرنامج
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الشكل )7-4(: إشارة بدء تشغيل البرنامج.

)User Interface( 2- واجهة المستخدم

تظهر واجهة المستخدم في برنامج الرسم باستعمال الحاسوب بعد التشغيل، إيذاناً ببدء عملية إنشاء رسوم 
جديدة، أو تعديل أخرى قديمة. هناك مساحتان منفصلتان للعمل في واجهة البرنامج، وتمتد مساحة الرسم 

لتشمل معظم الشاشة، وهناك أشرطة أدوات أعلى مساحة الرسم وأسفلها، أنظر الشكل )5-7(.

الشكل )7-5(: واجهة المستخدم.

مساحة الرسم

شريط الأوامر السفلي

شريط الأدوات العلوي

إشارة البدء التي تحوي رقم الإصدار لنسخة البرنامج بحسب سنة الإصدار، أنظر الشكل )4-7(.
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تشمل واجهة المستخدم في برنامج الرسم باستعمال الحاسوب ما يأتي:

أ - زر التطبيق )Application Menu(: يشير حرف )A( الأحمر الكبير في الزاوية اليسرى العلوية 
من الشاشة إلى زر التطبيق كما في الشكل )6-7(.

الشكل )7-6(: زر التطبيق.

زر التطبيقشريط الأدوات السريع

عند الضغط على زر التطبيق، تظهر قائمة الأوامر المُبيَّنة في الشكل )7-7(.

صورة الدالة قائمة الأوامر المعنى باللغة العربية

New إنشاء ملف جديد:

Open فتح ملف:

Save حفظ الملف:

Save As حفظ الملف باسم آخر:

Import استيراد من خارج الملف:

Export تصدير الملف بصيغ أخرى:

Publish نشر الملف:

Print طباعة الملف:

Drawing Utilities أدوات مفيدة للملف:

Close إغلاق الملف:

Options اختيارات متعلقة بالملف:

Exit AutoCAD الشكل )7-7(: محتويات زر التطبيق.الخروج من البرنامج:
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التطبيق،  زر  بجوار  الشريط  هذا  يوجد   :)Quick Access Toolbar( السريع  الأدوات  شريط  ب- 
وتراجع،  وطباعة،  باسم،  وحفظ  وحفظ،  وفتح،  جديد،  مثل:  الستعمال،  شائعة  الأوامر  ويحوي 
وإلغاء التراجع. ويمكن تعديل محتوياته بإضافة أوامر غير مدرجة، أو حذف أوامر موجودة بحسب 

حاجة المستخدم، أنظر الشكل )8-7(.

الشكل )7-8(: شريط الأدوات السريع.

.)Menu Bar( إظهار شريط القوائم المنسدلة :)الشكل )7-9

 AutoCAD( لتحويل واجهة المستخدم إلى
Classic( من شريط الأدوات السريع، يجب 
 Customize( الضغط على سهم التخصيص
Quick Access Toolbar(، لتظهر قائمة 
آنفاً،  المذكورة  الستعمال  شائعة  الأوامر 
 )Show MenuBar( خيار  يخُتار  ومنها 

كما في الشكل )9-7(.

جـ - شريط القوائم المنسدلة )Menu Bar(: يوجد هذا الشريط أسفل شريط الأدوات السريع، ويحتوي 
منها  كل  ويتضمَّن  الحاسوبية  البرامج  بقية  مثل  كلها  البرنامج  لأوامر  الرئيسة  المجموعات  على 
مجموعة أوامر فرعية تتشابه في طريقة عملها، أو يرتبط بعضها ببعض ضمن موضوع واحد، 

وتظهر هذه القائمة عند الضغط على موضوعها الرئيس، أنظر الشكل )10-7(.

الشكل )7-10(: شريط القوائم المنسدلة.
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من  سلسلة  ويحوي  المنسدلة،  القوائم  شريط  تحت  الشريط  هذا  يقع   :)Ribbon( الأدوات  شريط  د - 
ر، وعرض(، ومجموعة من الأدوات والأوامر  الأبواب )مثل: الرئيسة، وإدخال، وشروح، وتصوُّ

القياسية، مثل: أيقونات الرسم )Draw(، وأيقونات التعديل )Modify(، أنظر الشكل )11-7(.

الشكل )7-11(: شريط الأدوات.

لإخفاء شريط الأدوات والإبقاء على شريط القوائم المنسدلة لتوفير مساحة رسم أكبر، تخُتار القائمة 
)Tools( من القوائم المنسدلة )Menu Bar(، ثم يخُتار من القائمة خيار )Palettes(، ثم يضُغَط 

على خيار )Ribbon(  كما في الشكل )12-7(.

الشكل )7-12(: إخفاء شريط الأدوات.

الشكل )7-13(: شريط الحالة.

هـ - شريط الحالة )Status Bar(: يمتد هذا الشريط أسفل الشاشة، ويحوي إعدادات التحكم في مساحة 
الرسم من حيث المظهر، وكيفية إدخال المعطيات، وهي إعدادات تتيح للمستخدم مراقبة التغييرات 

في لوحة الرسم، أنظر الشكل )13-7(.
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شريط أدوات الأوامر )Command Line(: يقع هذا الشريط فوق شريط الحالة مباشرة، وهو نافذة  و- 
نصية تعُرَض فيها الأوامر التي نفُِّذت والإدخالت المنتهية، أو يسُتفاد منها في قراءة المرحلة التالية 

من مراحل الرسم، أنظر الشكل )14-7(.

الشكل )7-14(: شريط أدوات الأوامر.

استعمال البرنامج في الرسم ثالثًا

يحتوي برنامج الرسم باستعمال الحاسوب على العديد من الأدوات والأوامر والأزرار اللازمة لإتمام 
عملية الرسم. وفي ما يأتي بيان لكل منها:

)Tabs Bar( شريط علامات التبويب

ر، وعرض،  يحتوي هذا الشريط على سلسلة من الأبواب، مثل: الرئيسة، وإدخال، وشروح، وتصوُّ
أنظر الشكل )15-7(.

الشكل )7-15(: شريط علامات التبويب.

Tab Bars

Panel

Click to expand panel
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يحتوي الباب الأول من شريط علامة التبويب على القائمة الرئيسة )Home( التي تحتوي على أهم الأدوات 
الرئيسة للرسم والتصميم، مُنظَّمة في لوحات )Panels( على النحو الآتي:

)Draw( 1- لوحة الرسم

تحتوي هذه اللوحة على العناصر الهندسية الرئيسة، مثل: الخط المستقيم، ومتعدد الخطوط، والدائرة، 
والقوس، والمضلعات، والشكل البيضوي، فضلًا عن أداة التهشير )التظليل( لأيٍّ من الأشكال، أو أيِّ 

منطقة يراد تهشيرها بالنوع المناسب عن طريق الضغط المزدوج على أيٍّ منها.

يمكن رسم هذه الأشكال والعناصر بالضغط على اختصاراتها الآتية في لوحة المفاتيح، علمًا بأن هذه 
الختصارات هي من أهم مزايا برنامج الرسم باستعمال الحاسوب؛ سواء للأدوات، أم للأوامر:

قائمة الأوامر المعنى باللغة العربية
)Command: Line( L+Enter رسم خط:

)Command: Arc( ARC+Enter رسم قوس:

)Command: Hatch( H+Enter تهشير:

)Command: Circle( C+Enter رسم دائرة:
Command: Rectangle
REC + Enter

رسم مستطيل:

)Command: Polyline(
PLINE + Enter

رسم شكل متعدد الخطوط:

قائمة الأوامر المعنى باللغة العربية
)Command: Rotate ( Ro + Enter تدوير العنصر

)Command: Mirror ( Mi + Enter انعكاس العنصر

)Command: Scale ( Sc + Enter تغيير مقياس الرسم

)Command:Move ( M + Enter تحريك العنصر

)Command: Copy ( CO + Enter نسخ العنصر

)Command: Stretch( S + Enter تمديد العنصر

)Modify( 2- أوامر التعديل

تتضمَّن هذه الأوامر الأدوات الآتية اللازمة للتعديل على الرسوم والأشكال الهندسية المرسومة.
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)Annotation( 3- لوحة الشروح

يسُتفاد من لوحة الشرح في إضافة أيِّ ملاحظة خطية بإدراج نوع خط للكتابة )Text Style(، واختصاره 
)Sty(، والتحكم في خصائصه، أو إضافة مسافة )Dimension( بين أيِّ عنصرين، وتحديد طبيعة 
المسافة )مستقيمة، مائلة، نصف قطُْر(، ونوع وحدة القياس، واختصاره )Dim +Enter(، أو إضافة 

تعليق بسهم دللة )Leader(، أو إدراج جدول أسطر وأعمدة، أنظر الشكل )16-7(.

الشكل )7-16(: لوحة الشرح.

)Layers( 4- الطبقات

العمل على  ع  التنظيمية في برنامج الرسم باستعمال الحاسوب. وفيها يوُزَّ العمل  تمُثِّل الطبقات لوحة 
مجموعات منفصلة متماثلة من حيث الخصائص، تسُمّى الطبقة )Layer( التي يمكن التحكم فيها عن 
 Layer( الطبقة  خصائص  خيار  في  توجد  وهي  الطبقة،  واسم  ولونه،  وسُمْكه،  الخط،  نوع  طريق 

Properties(، أنظر الشكل )17-7(.

الشكل )7-17(: الطبقات.

حذف طبقة حالية
Delete layer إنشاء طبقة جديدة

New layer
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)Block( 5- النموذج

المشروع(، بحيث  ثابتة في  النموذج في تحديد رسمٍ أو مجموعة عناصر )بوصفها وحدة  يسُتفاد من 
يمكن تسميتها، واستردادها في أيِّ مرحلة من دون حاجة إلى إعادة رسمها، مثل: العناصر المتكررة، 

والعناصر دقيقة التفاصيل، مثل: البراغي، والصواميل، والرموز، أنظر الشكل )18-7(.

الشكل )7-18(: النموذج.

تطبيقات عملية باستعمال البرنامج رابعًا

تعَُدُّ عملية الرسم باستعمال الحاسوب عملية تشاركية مع الإنسان الذي يمُثِّل ركنها الرئيس؛ إذ تعتمد 
عملية إتقان الرسم على خيال المستخدم، وقدرته على حفظ الأوامر الموجودة في برنامج الرسم، وسرعة 

اختياره للخطوة التالية في أثناء عملية الرسم.

1- أوامر الرسم

أ - أمر رسم الخط )Line(: يعَُدُّ أحد أهم الأوامر الموجودة في البرنامج وأسهلها، ويمُثِّل اللبنة الأساسية 
لمعظم الأشكال، ويمكن الوصول إليه بإحدى الطرائق الآتية:

.)Draw →Line( 1. أوامر القوائم الرئيسة

.)Enter( ثم الضغط على زر إدخال ،) L( أو ،)Line( 2. كتابة

3. أو الضغط على الأيقونة الممثلة لهذا الأمر في شريط أدوات الرسم على واجهة المستخدم، وهي 
الأيقونة الأولى، أنظر الشكل )19-7(.
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الشكل )7-19(: أمر الرسم.

تحديد  المستخدم  إلى  البرنامج  يطلب  الأمر،  على  الضغط  عند 
نقطة  تحديد  )يمكن  الأوامر  موجه  في  يظهر  كما  البداية  نقطة 

البداية بإحدى الطرائق المذكورة آنفاً(، ثم تحديد نقطة النهاية.

أمر رسم الخط المرن )Sketch(: يمكن استعمال هذا الأمر باتباع الخطوات الآتية: ب- 

.)Enter( ثم الضغط على زر إدخال ،)Sk( أو ،)Sketch( 1. كتابة الأمر أو اختصاره من لوحة المفاتيح

2. الضغط المستمر، وبدء الرسم بتحريك الفأرة.

3. تكرار عمليتي الضغط والتحريك حسب الحاجة.

4. الضغط على زر إدخال )Enter( لإنهاء الأمر، وإكمال عملية الرسم، أنظر الشكل )20-7(.

الشكل )7-20(: أمر رسم الخط المرن.

الجدول )7-1(: رموز أوامر
الرسم والتعديل.
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جـ - أمر الرسم الدائرة )Circle(: يمكن استعمال هذا الأمر باتباع الخطوات الآتية:  

1. الضغط على الأيقونة الخاصة به من شريط أدوات الرسم.

.)Enter( ثم الضغط على زر إدخال )C( أو ،)Circle( 2. كتابة

عند إعطاء أمر الرسم هذا يظهر في شريط موجه الأوامر الرسالة الآتية:

مركز  د  حدِّ وتعني:   ،)Specify center point for circle of 3P/2P/Ttr tan tan radius(
الدائرة: نقطتين على المحيط  الدائرة بحسب الخيار الفتراضي، أو اختر إحدى الطرائق الآتية لرسم 

ونصف القطُْر، أو ثلاث نقاط على المحيط ونصف القطُْر، أو مماسين مع نصف القطُْر.

الشكل )7-21(: رسم الدائرة.

ثم  الشكل )21(،  القطُْر كما في  المستخدم تحديد نصف  إلى  البرنامج  الدائرة يطلب  عند تحديد مركز 
ثم  الكبير(،  الحرف  )يكُتبَ  أحدها  لنتقاء  ]…[؛  القوسين  بين  المتوافرة  الخيارات  البرنامج  يحصر 
يحصر البرنامج الخيار الفتراضي بين القوسين )...( الذي يمكن تفعيله عند الضغط على زر إدخال 

)Enter(، فيظهر خيار إدخال الرقم بين القوسين < ... >.

د - أمر رسم مستطيل )Rectangle(: يمكن استعمال هذا الأمر باتباع الخطوات الآتية:

1. الضغط على الأيقونة الخاصة به من شريط أدوات الرسم.

2. اختيار أمر )Draw → Rectangle( من القائمة.

.)Enter → Rec( 3. كتابة

عند إعطاء أمر الرسم هذا يظهر في شريط موجه الأوامر الرسالة الآتية: 

الأولى )بوصفها خيارًا  المستطيل  تحديد زاوية  بها  يراد  التي   ،)Specify First Corner Point(
افتراضياًّ( مع مجموعة من الخيارات المرفقة؛ لذا يجب تحديد النقطة التي تمُثِّل الزاوية الأولى، فتظهر 
الزاوية  الثانية؛ شرط أن يكون تحديدها عن  الزاوية  تمُثِّل  التي  النقطة  لتحديد  آنفاً؛  المذكورة  الرسالة 

الأولى بشكل قطُْري، علمًا بأنه يمكن تحديد النقاط بأيٍّ من الطرائق السابقة، أنظر الشكل )22-7(.
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الشكل )7-22(: أمر رسم المستطيل.

الزاوية الثانية

الزاوية الأولى

هـ - أمر رسم المضلع )Polygon(: يمكن استعمال هذا الأمر باتباع الخطوات الآتية: 

1. الضغط على الأيقونة الخاصة به من شريط أدوات الرسم.

2. اختيار أمر )Draw →Polygon( من القائمة.

.)Enter → Pol( 3. كتابة

يسُتعمَل هذا الأمر لرسم مضلع متساوي الأضلاع على النحو الآتي:

1. اختيار أمر رسم المضلع )Polygon( من شريط أدوات الرسم على واجهة المستخدم.

2. إدخال عدد أضلاع الشكل المطلوب )6 مثلًا(. 

3. تحديد مركز الشكل المضلع.

.)Enter( 4. الضغط على زر إدخال

5. تحريك الفأرة، والضغط المستمر لتحديد نصف القطُْر لدائرة وهمية، أو إدخال نصف القطُْر من 
لوحة المفاتيح، فيظهر المضلع كما في الشكل )23-7(.

الشكل )7-23(: رسم المضلع.
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باستعمال  الرسم  برنامج  في  المهمة  الأوامر  أحد   )Hatch( التهشير  أمر  يعَُدُّ   :)Hatch( التهشير   - و 
الحاسوب، ول سيَّما في رسم القطاعات، ويمكن الوصول إليه بالضغط على أيقونته في شريط أدوات 

الرسم، فتظهر خيارات التهشير كما في الشكل )24-7(.

الشكل )7-24(: نافذة أمر التهشير.

نافذة أنماط التهشيرزاوية التهشير

مقياس رسم التهشير

في ما يأتي الخطوات الواجب اتباعها لستعمال أمر التشهير:

.)Pattern( 1. اختيار نوع التهشير من نافذة أنماط التهشير

.)Hatch pattern scale( 2. تحديد مقياس رسم التهشير

.)Hatch angle( 3. تحديد زاوية التهشير

4. الضغط بالفأرة على المنطقة التي يراد تهشيرها؛ شرط إحاطة المساحة، وتظليلها كلها. 

5. في حالة الأشكال المغلقة )مثل: المربع، والدائرة، والمضلع(، يحُدَّد العنصر باستعمال الفأرة.

6. الضغط على زر إدخال )Enter( لتنفيذ الأمر وإنهائه، أنظر الشكل )25-7(.

الشكل )7-25(: مثال على تطبيق أمر التهشير.

فائدة

 )Circumscribed( المضلع بطول ضلع معلوم، ويسُتعمَل خيار يسُتعمَل خيار )Edge( لرسم 
لرسم مضلع خارج محيط الدائرة. أرَسُم شكلًا سداسياًّ باستعمال الطريقتين.
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2- أوامر التعديل

أ  - أمر التحريك والنقل )MOVE(: يسُتعمَل هذا الأمر كثيرًا لتحريك عناصر الرسم ونقلها من مكان 
إلى آخر.

في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر )Modify → Move( من القائمة.

2. الضغط على الأيقونة الخاصة بالأمر من شريط أدوات التعديل.

.)Enter( ثم الضغط على زر إدخال ،)M( أو ،)Move( 3. كتابة الأمر أو اختصاره من لوحة المفاتيح

عند اختيار أمر التحريك والنقل )Move( يطلب البرنامج إلى المستخدم تحديد العناصر التي يراد 
.)Select Objects( تحريكها

4. تحديد العناصر التي يراد تحريكها بإحدى طرائق التحديد )الضغط، نافذة التقاطع، نافذة الحتواء(، 
أنظر الشكل )26-7(.

الشكل )7-26(: أمر التحريك والنقل.

5. طلب البرنامج إلى المستخدم تعيين نقطة أصل للعناصر المطلوبة؛ للتحكم في المكان الذي يراد  
نقل العناصر إليه؛ سواء أكانت هذه النقطة من نقاط العناصر المختارة أم ل.

6. طلب البرنامج إلى المستخدم تعيين نقطة تمُثِّل مكان نقل نقطة الأصل؛ لنقل العناصر المختارة جميعها.

نقطة الأصل

العنصر المنقول

العنصر المراد نقله

نقطة النقل
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ب- أمر الانعكاس )Mirror(: يسُتعمَل هذا الأمر لتكرار العناصر مع عكس اتجاهها، وبقاء الأصل أو حذفه.

في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر )Modify →Mirror( من القائمة.

2. الضغط على الأيقونة الخاصة بالأمر من شريط أدوات التعديل.

3. كتابة الأمر أو اختصاره من لوحة المفاتيح )Mirror(، أو )Mi(، ثم الضغط على زر إدخال 
.)Enter(

4 .عند اختيار الأمر )Mirror( يطلب البرنامج إلى المستخدم تحديد العناصر التي يتعيَّن عكسها 
.)Select Objects(

5. تحديد العناصر التي يراد عكسها بإحدى طرائق التحديد )الضغط، نافذة التقاطع، نافذة الحتواء(.

6. تحديد النقطة الأولى من خط النعكاس، ثم تحديد النقطة الثانية لتشكيل خط النعكاس.

7. ظهور السؤال الآتي على الشاشة: هل تريد مسح العنصر الأصيل عند عكسه أم تركه كما هو؟

8. الضغط على زر إدخال )Enter( لتنفيذ الأمر وإنهائه، أنظرُ الشكل )27(.

.)Mirror( أمر النعكاس :)الشكل )7-27

العنصر المطلوب عكسه

خط النعكاس

العنصر المعكوس

جـ - أمر القطع )Trim(: يسُتعمَل هذا الأمر لقطع الأجزاء الزائدة من عنصر ما عن حدود خط معين. 

في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر )Modify →Trim( من القائمة.

2. الضغط على الأيقونة الخاصة بالأمر من شريط أدوات التعديل.
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.)Enter( ثم الضغط على زر إدخال ،)Tr( أو ،)Trim( 3. كتابة الأمر أو اختصاره من لوحة المفاتيح

.)Select cutting edge( يطلب البرنامج إلى المستخدم تحديد خط القطع )Trim( 4. عند اختيار أمر

5. تحديد الخط الذي يمُثِّل حدود القطع باستعمال الفأرة.

.)Select Objects to trim( 6. طلب البرنامج إلى المستخدم تحديد أجزاء العناصر المراد قطعها

7. تحديد العناصر المراد قطعها باستعمال الفأرة.

8. الضغط على زر إدخال )Enter( لتنفيذ الأمر وإنهائه، أنظر الشكل )28-7(.

الشكل )7-28(: أمر القطع.

الجزء المراد قطعه

خط حدود القطع

د - أمر التمديد )Extend(: يسُتعمَل هذا الأمر لتمديد الأجزاء الناقصة من عنصر ما عن حدود خط معين.

في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر )Modify → Extend( من القائمة.

2. الضغط على الأيقونة الخاصة بالأمر من شريط أدوات التعديل.

.)Enter( ثم الضغط على زر إدخال ،)Ex( أو ،)Extend( 3. كتابة الأمر أو اختصاره من لوحة المفاتيح

4. عند اختيار أمر التمديد )Extend( يطلب البرنامج إلى المستخدم تحديد خط حدود تمديد العناصر 
.)Select boundary edge(

5. تحديد خط حدود التمديد باستعمال الفأرة.

.)Select Objects to extend( 6. طلب البرنامج إلى المستخدم تحديد العناصر المراد تمديدها

7. تحديد العناصر المراد تمديدها باستعمال الفأرة.

8. الضغط على زر إدخال )Enter( لتنفيذ الأمر وإنهائه، أنظر الشكل )29(.
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الشكل )7-29(: أمر التمديد.

خط حدود التمديد

الجزء المراد تمديده

هـ - أمر المسح )Erase(: يسُتعمَل هذا الأمر كثيرًا في الرسم لمسح العناصر المرسومة.

في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر )Modify → Erase( من القائمة، أو من شريط أدوات التعديل.

إدخال  ثم الضغط على زر   ،)E( أو  ،)Erase( المفاتيح أو اختصاره من لوحة  2. كتابة الأمر 
.)Enter(

 Select( 3. بعد اختيار أمر المسح بإحدى الطرائق السابقة يظهر على الشاشة خيار اختر العناصر
Object(، في إشارة إلى العناصر التي يريد المستخدم مسحها. 

ل المؤشر إلى مربع صغير، ثم اختيار المستخدم العنصر بالنقر المباشر عند ظهور المربع  4. تحوُّ
الصغير، أنظر الشكل )30-7(.

5. بعد اختيار العناصر المطلوبة، فإنها تظهر بخط رفيع أو متقطع، ثم يضغط المستخدم على زر 
الفأرة الأيمن، أو على زر إدخال )Enter( لإنهاء الأمر، والموافقة على مسح العناصر المختارة.

الشكل )7-30(: أمر المسح.
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و - أمر الموازي )Offset(: يسُتعمَل هذا الأمر لتكرار عنصر ما في التجاه نفسه، وعلى نحوٍ موازٍ 
له، بحيث يبعد مسافة معينة عن العنصر الأصلي.

في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر )Modify → Offset( من القائمة.

2. الضغط على الأيقونة الخاصة بالأمر من شريط أدوات التعديل.

.)Enter( ثم الضغط على زر إدخال ،)O( أو ،)Offset( 3. كتابة الأمر أو اختصاره من لوحة المفاتيح

4. عند اختيار أمر الموازي )Offset( يطلب البرنامج إلى المستخدم تحديد خط المسافة المطلوبة 
.)Select offset distance( بين العنصر والعنصر المنسوخ منه

5. تحديد المسافة المطلوبة بإدخال الرقم أمام القوسين >…< عن طريق كتابته من لوحة المفاتيح.

.)Select Objects to offset( 6. طلب البرنامج إلى المستخدم تحديد العنصر المراد نسخه

7. تحديد العنصر المراد تكراره باستعمال الفأرة.

8. تحديد الجهة التي يراد تكرار العنصر إليها بالضغط على الجهة المطلوبة نسبة إلى العنصر المكرور.

9. الضغط على زر إدخال )Enter( لتنفيذ الأمر وإنهائه، أنظر الشكل )31-7(.

الشكل )7-31(: أمر الموازي.

العنصر المكرور

العنصر المراد تكراره
اتجاه التكرار
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3- أوامر تصفح الرسم

أ - أمر معاينة الرسم )Zoom(: إن استعمال هذا الأمر ل يغير الحجم المطلق لمكونات الرسم، وإنما 
يغير فقط مساحة العرض.

في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. كتابة أمر معاينة الرسم )Zoom(، أو اختصاره )Z( باستعمال لوحة المفاتيح.
2. تحديد الخيار المطلوب بكتابة حرفه الكبير:

يمكن تقريب الرسم وإبعاده بالضغط على عجلة الفأرة )Mouse Scroll( مع تحريك الفأرة؛ ما يتيح 
تنفيذ الأمر على نحوٍ مماثل لأمر التحريك )Pan( بسرعة ومرونة أكثر.

قائمة الأوامر المعنى باللغة العربية
All إظهار جميع العناصر

Center إظهار لوحة الرسم بتحديد مركز الإظهار

Dynamic إظهار بواسطة مربع مرن ومتغير

Extents إظهار أقصى حدود لجميع المكونات

Previous إظهار العرض السابق

Scale
إلى  نسبة  أو أصغر  أكبر  بمقياس  اللوحة  إظهار 

)X( العرض الحالي، وكتابة الرقم متبوعًا بـ

Window إظهار المساحة المُحدَّدة بنافذة مستطيلة

Object
إظهار العنصر المُحدَّد بالمؤشر بأكبر حجم ممكن 

وفي وسط العرض

)Pan( ب- أمر التحريك

البرنامج بصورة تشبه أمر معاينة  1. يسُتعمَل هذا الأمر لتحريك عرض الرسم ضمن حدود واجهة 
الرسم )Zoom(، وذلك بطباعة أمر التحريك )Pan(، أو اختصاره )P(، ثم الضغط على زر إدخال 

.)Enter(
2. تظهر الرسالة الآتية عند إعطاء الأمر  في شريط موجه الأوامر:

)Specify base Point or displacement(، ويراد بها تحديد نقطة أصل لمسافة الحركة.
 Specify( الثانية  النقطة  تحديد  المستخدم  إلى  البرنامج  فيطلب  اللوحة،  في وسط  ما  نقطة  تحُدَّد   .3

second point(. وبعد تحديدها يتحرك الرسم بمقدار المسافة والتجاه بين النقطتين.
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4- أوامر الشرح

أ - أمر الكتابة )Text(: في ما يأتي الخطوات الواجب اتباعها لستعمال هذا 
الأمر:

بالضغط على   )Single Line( واحد  إنشاء نص سطر  أمر  اختيار   .1
الأيقونة الخاصة به.

.)Enter( ثم الضغط على زر إدخال ،)Text( 2. كتابة أمر الكتابة
3. تحديد نقطة بداية النص )Specify Start Point of Text( باستعمال الفأرة، والضغط على 

المكان المطلوب.
4. تحديد ارتفاع النص )Specify height( باستعمال لوحة المفاتيح.

5. تحديد زاوية ميل النص )Specify rotation angle of text( بكتابة قيمة الزاوية، أو الزاوية 
.>0º< التي يفترضها البرنامج

6. بدء الكتابة باستعمال لوحة المفاتيح، فيظهر النص على الشاشة، أنظر الشكل )32-7(.

الشكل )7-32(: أمر الكتابة.

التمرين )2(
.)Multiline Text( )مُستعمِلًا أسلوب الكتابة السابق نفسه، أطُبِّق خيار كتابة نص متعدد )فقرة

ب- أمر الأبعاد )Dimension(: يندرج تحت 
 )Dimension( مظلة أمر الأبعاد الرئيسة
مجموعة من الأوامر الفرعية، التي يمكن 
على  بالضغط  خصائصها  في  التحكم 
الأيقونة الموجودة في لوحة الشرح الرئيسة 

)Annotation(، أنظر الشكل )33-7(.
الشكل )7-33(: نافذة الشرح.

أمر الأبعاد

أيقونة الشرح الرئيسة
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يسُمّى كل أمر تبعًا لنوع البعُْد المطلوب )خطي، اصطفافي، قياس زاوية، طول قوس، نصف قطُْر، 
قطُْر، إحداثيات، نصف قطُْر إرشادي(، أنظرُ الشكل )34-7(.

الشكل )7-34(: قائمة أوامر الأبعاد.

الأبعاد الخطية )أفقية، وعمودية(

الأبعاد الصطفافية

قياسات الزوايا

قياسات الأقواس

قياس نصف القطُْر

قياس القطُْر

الإحداثيات

قياس نصف قطُْر إرشادي

أمر الأبعاد الخطية )Linear(: في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر الأبعاد الخطية )Linear( من القائمة بالضغط على الأيقونة الخاصة به.

 Specify first extension(  2. تحديد النقطة الأولى من نقاط خط البعُْد المطلوب حسب طلب البرنامج
line origin( باستعمال الفأرة.

3. تحديد النقطة الثانية )Specify second extension line origin( باستعمال الفأرة.

4. تحديد مكان رسم خط البعُْد )Specify dimension line location( باستعمال الفأرة، فيظهر خط 
البعُْد المحدد كما في الشكل )35-7(.
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الشكل )7-35(: أنواع خطوط القياس.

)Linear( خط بعُْد أفقي)Linear( خط بعُْد عمودي

)Angular( قياس زاوية

)Aligned( خط بعُْد اصطفافي

)Radius( قياس نصف قطُْر

)Diameter( قياس قطُْر
)Arc length( طول قوس

أمر قياس الزوايا )Angular(: في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر قياس الزوايا )Angular( من القائمة بالضغط على الأيقونة الخاصة به.

2. تحديد الخط الأول من مكونات الزاوية حسب طلب البرنامج )Select line( باستعمال الفأرة.

3. تحديد الخط الثاني من مكونات الزاوية )Select second line( باستعمال الفأرة.

4. تحديد مكان رسم قياس الزاوية )Specify dimension arc line location( باستعمال الفأرة، 
فتظهر قيمة قياس الزاوية في المكان المحدد كما في الشكل )35(.

أمر طول القوس )Arc length(: في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار أمر طول القوس )Arc length( من القائمة بالضغط على الأيقونة الخاصة به.

2. تحديد القوس حسب طلب البرنامج )Select arc segment( باستعمال الفأرة.

3. تحديد مكان رسم طول القوس )Specify arc length dimension location( باستعمال الفأرة، 
فيظهر طول القوس في المكان المحدد كما في الشكل )35(.
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أمر قياس نصف القطُْر )Radius(: في ما يأتي الخطوات الواجب اتباعها لستعمال هذا الأمر:

1. اختيار قياس نصف القطُْر )Radius( من القائمة بالضغط على الأيقونة الخاصة به.
2. تحديد القوس أو الدائرة حسب طلب البرنامج )Select arc or circle( باستعمال الفأرة.

3. تحديد مكان رسم نصف القطُْر )Specify dimension line location( باستعمال الفأرة، فيظهر 
قياس نصف القطُْر في المكان المحدد كما في الشكل )35-7(.

جـ - أمر التراجع )Undo(: يوجد هذا الأمر في شريط أدوات الولوج السريع، ويسُتعمَل غالباً للتراجع عن 
أمر نفُِّذ في الرسم. فمثلًا، إذا أراد المستخدم التراجع عن عملية المسح التي قام بها في الفقرة السابقة، 
فإنه يكتب أمر التراجع )Undo(، أو اختصاره )U(، ثم يضغط على زر إدخال )Enter(، فتظهر 
العناصر التي مُسِحت، علمًا بأنه يمكن تكرار تنفيذ هذا الأمر للتراجع عن العمليات التي نفُِّذت سابقاً، 
فضلًا عن إمكانية استعمال أداة التراجع الموجودة في شريط أدوات الوصول السريع كما في الشكل 

.)36-7(

الشكل )7-36(: أمر التراجع.
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التمرين )3(

أرَسمُ الشكل الآتي:

التمرين )4(

أرَسمُ الشكل الآتي:
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الإثراء والتوسع

.)AUTOCAD( رسم العلم الأردني باستعمال برنامج الرسم بالحاسوب

العلم الأردني هو العلم الرسمي للمملكة الأردنية الهاشمية الذي يمُثِّل الدولة، وسيادتها، ومؤسساتها، 
ومواطنيها، وقد وُصِف العلم في المادة الرابعة من الدستور الأردني كما يأتي:

" تكون الراية الأردنية على الشكل والمقاييس الآتية: طولها ضعف عرضها، وتقسم أفقياًّ ثلاثَ قطع 
ناحية  بيضاء، والسفلى خضراء، يوضع عليها من  منها سوداء، والوسطى  العليا  متساوية متوازية، 
السارية مثلث قائم أحمر قاعدته مساوية لعرض الراية، وارتفاعه مساوٍ لنصف طولها. وفي هذا المثلث 
كوكب أبيض سباعي الأشعة مساحته ممّا يمكن أن تستوعبه دائرة قطُْرها واحد من أربعة عشر من 
طول الراية، وهو موضوع بحيث يكون وسطه عند نقطة تقاطع الخطوط بين زوايا المثلث، وبحيث 

يكون المحور المار من أحد الرؤوس موازياً لقاعدة هذا المثلث. "

�

�

� �

�

�

�

�

��

�

�

�

�

�

�



122

:)AUTOCAD( خطوات رسم العلم الأردني باستعمال برنامج الرسم بالحاسوب

الرسم التوضيحي الخطوة الرقم
تحديد نقطة على الصفحة، ثم رسم 

 ،)Line( المستطيل باستعمال أمر الخط
أو استعمال أمر رسم المستطيل 

.)Rectangle(

1

رسم المستطيلات الداخلية باستعمال أمر 
الخط )Line(، أو استعمال أمر رسم 

.)Rectangle( المستطيل

2

رسم المثلث باستعمال أمر الخط 
)Line(، أو استعمال أمر رسم المضلع 

.)polygon(

3

رسم الدائرة باستعمال أمر الدائرة 
.)Circle(

4

رسم المضلع السباعي داخل الدائرة 
من مركزها باستعمال أمر المضلع 

.)Polygon(

5
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الرسم التوضيحي الخطوة الرقم
رسم الخط من )1( إلى )2(، ثم رسم 
الخط من )1( إلى )3( باستعمال أمر 

.)Line( الخط

6

اختيار أمر )Polar Array(، ثم التحديد 
من قائمة )Modify(، ثم التحديد على 
الخطين داخل المضلع، ثم الضغط على 

زر إدخال )Enter(، ثم  تحديد عدد )7( 
.)Item( من العناصر

7

اختيار أمر )Trim( من قائمة 
)Modify(، ثم حذف الخطوط غير 

الضرورية.

8

ينتج شكل العلم الأردني. 9

اختيار أمر )Hatch( من قائمة 
)Draw(، ثم تلوين العلم.

10

�

�
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يمكنني بعد دراسة هذه الوحدة أن: 

بحاجة للتحسين جيد ممتاز مؤشر الأداء الرقم

ح مفهوم الرسم باستعمال الحاسوب. أوُضِّ 1

ف مكونات واجهة الرسم باستعمال الحاسوب. أتَعرَّ 2

أطُبِّق أوامر تصفُّح الرسم. 3

أطُبِّق أوامر رسم بعض الأشكال الهندسية. 4

أطُبِّق أوامر التعديل. 5

أرَسُم بعض الأشكال البسيطة. 6

أقُارِن بين الرسم التقليدي والرسم باستعمال الحاسوب. 7

أقَرأ اللوحات المرسومة باستعمال الحاسوب. 8

القياس والتقويم

الإثراء والتوسع

باستخدام برنامج )AutoCAD(، أرسمُ بعض المناظير التي رسمتهُا في الوحدة الرابعة باستخدام 
. )AutoCAD( الأدوات الهندسية، وأقارنُ بين رسمي بالأدوات الهندسية وبرنامج
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تمارين الوحدة
التمرين الأول

التمرين الثاني

.)AutoCAD( أرَسمُ الشكل الآتي باستخدام برنامج

.)AutoCAD( أرَسمُ الشكل الآتي باستخدام برنامج
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التمرين الثالث

التمرين الرابع

.)AutoCAD( أرَسمُ الشكل الآتي باستخدام برنامج

.)AutoCAD( أرَسمُ الشكل الآتي باستخدام برنامج
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التمرين الخامس

أرَسمُ الشكل الآتي باستخدام الأدوات الهندسية، ثم أرسمه باستخدام برنامج )AutoCAD(، وأقارن بين 
الرسمين.

AutoCAD
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Modify التعديل
Extend التمديد
Hatch التهشير
Draw الرسم
Free Hand Drawing الرسم الحر
Sectional Drawing الرسم القطاعي )المقطعي( 
Three Dimensional Drawings)3D( الرسم ثلاثي الأبعاد
Layers الطبقات
Partial Section القطاع الجزئي
Full Section القطاع الكامل
Offset Section القطاع المتنقل
Trim القطع
Top Plane المستوى الأفقي
Front Plane المستوى الأمامي
Profile Plane المستوى الجانبي
Projection المنظور   
Oblique Projection المنظور الجبهي
Cavalier Oblique Projection المنظور الجبهي الطويل 
General Oblique Projection المنظور الجبهي العام
Cabinet Oblique Projection المنظور الجبهي القصير
Parallel Projection المنظور المتوازي 
Isometric Projection المنظور المتوازي المتساوي 
Perspective Projection المنظور المركزي
Front Face الوجه الأمامي 
Left Side Face الوجه الجانبي الأيسر
Right Side Face الوجه الجانبي الأيمن 
Rear Face الوجه الخلفي

مسرد المصطلحات
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Bottom Face الوجه السفلي
Top Face الوجه العلوي
AutoCAD برنامج الرسم باستعمال الحاسوب
Ribbon شريط الأدوات  
Quick Access Toolbar شريط الأدوات السريع
Status Bar شريط الحالة
Menu Bar شريط القوائم المنسدلة
Command Line شريط أدوات الأوامر
Tabs Bar شريط علامات التبويب
Application Menu قائمة التطبيق
Aligned Section قطاع المحاذاة
Revolved Section قطاع المدار
Annotation لوحة الشرح
Section Plane مستوى القطع
Half Section نصف القطاع
User Interface واجهة المستخدم
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